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CHAPTER 1
GENERAL DESCRIPTION

This chapter gives an overview of the Battery Performance Checker and describes
the environment necessary to run it.

Sections in Chapter 1

1.1 Introduction
1.2 Environmental Requirements
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1.1 Introduction

The Battery Performance Checker (hereafter referred to in the user's manual as the
"BP checker') conducts performance tests on batteries by controlling the PEX40W-
08 charge/discharge tester via an external personal computer. The battery
performance test system stores the results of the test.

Using the BP checker, a single personal computer can control battery testing for up to
six PFX40W-08's, or a maximum of 48 channels.

There are two operation modes of the BP checker: life cycle mode and sequence
mode. The checker can be used in either mode. Life cycle mode is used to test battery
life characteristics according to separate conditions (worksheets) for each channel.
Test results are recorded in folders (which allow information managed using
worksheets to be managed in up to 99 worksheet files) and worksheets (scenarios
used to conduct tests). By conducting tests according to these conditions, life test
data for an extended period can be saved automatically. Sequence mode is used to
test initial battery characteristics which cannot be set for the PFX40W-08. Batteries
are tested by varying test conditions (stored in worksheets). Tests in which
conditions are varied according to folders created by assembling various worksheets
for each test scenario are automatically conducted, and separately measured data is
automatically stored.

The BP checker consists of the following five executable programs:

1. PFX Config

This executable is used to set the overall system environment and set common items
shared by a PFX unit.

2. Folder Editor

This executable is used to edit the contents of worksheets and folders organizing up
to 99 of these worksheets. Multiple worksheets can be saved in a folder. In life cycle
mode, tests are conducted by selecting one of these worksheets. In sequence mode,
tests are conducted by varying test conditions according worksheets sequence.

3. Test Executive

This executable starts and stops tests, and monitors test status for each channel
individually. It also automatically creates graphs and reports from test results and
saves them as files.

4. BPC Graph

This executable processes result files. It can create graphs, convert ranges for graphs,
overlay graphs, make tables for each file and provide other manipulations based on
result files. These results can be displayed on the screen or printed out. This
executable can also convert result files to a text format.
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5. BPC Spy

Test Executive includes DDE server functions which allow it to communicate with
other programs. BPC Spy is an application that utilizes this function to intercept
(obtain) data monitored by Test Executive.

In addition, user applications having DDE client functions can be created in a
language such as Visual Basic, allowing to send commands to other GPIB equipment
according to status change from the BP checker.

In this way, you can use the BP checker application software to implement a diverse
test system for checking battery performance which cannot be supported by the
PFX40W-08 alone.

1.2 Environmental Requirements

The following environment is required for BP checker to run smoothly.

M Personal computer

m  An IBM PC/AT or compatible machines running Windows 3.1 or Windows for
Workgroups 3.11.

An i486DX/33MHz CPU or better is recommended.

8MB of RAM or more is recommended.

20MB of available disk space or more.

A high resolution (SVGA 1024 x 768 or more) video subsystem is
recommended. The more windows to be opened at once, the larger the screen
required.

m A 17-inch or 20-inch display monitor is recommended.

B Communications environment

s GPIB board
National Instruments NI-488.2 or compatible GPIB board

m  GPIB cable
A 24-pin connector cable conforming to IEEE-488 GPIB standards is required
for each PFX unit being used.
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Using the GPIB Board

Windows Operations

When using a National Instruments GPIB board, it is necessary to install a Windows
device driver for the GPIB board. This device driver is contained on a diskette
included with the GPIB board. Refer to the documentation included with the GPIB
board for details on installation procedure. Also, be aware that data retrieval is not
always performed correctly when DMA mode is on. If this occurs, be sure to turn
DMA mode off.

1-4

BP checker runs under Windows 3.1 or Windows 95. The basic operations of
windows, menus, buttons, etc. are the same as for other Windows applications. For
details on common basic Windows operations, please refer to your Windows
documentation.

What to do Next

Continue on to Chapter 2, and make all necessary preparations (setup) for running
BP checker.

General Description




CHAPTER 2
SETUP

This chapter describes program installation and setting GPIB addresses of PFX units
which must be performed before actually using the BP checker.

Sections in Chapter 2

2.1 Package Contents

2.2 Installation

2.3 GPIB Settings for PFX Units
2.4 Connecting GPIB Cables
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2.1 Package Contents

The following items are included in the BP checker package.

[] Program diskettes 1
[] User's manual 1
|:| Performance limitations 1

2.2 Installation

Before using BP checker, first you have to install all programs into your hard disk.
Installation is performed using the setup program contained in the program diskette.
The following is a description of installation procedures.

. 1 NOTE ¢ ]

+ To novice users of Windows

BP checker runs under Windows 3.1 or Windows 95. The basic
operations of windows, menus, buttons, etc. are the same as for other
Windows applications. If you are new to using Windows and are
unsure of basic operations, please refer to your Windows
documentation.

About BPC Screen Blanker

BPC Screen Blanker which has a same function of Screen Saver "Scrolling
Marquee" is packed in the BP checker 2.1. We prepare this utility software as a
replacement for "Scrolling Marquee", that's why we found some computers had
troubled using the BPC Test Executive with Screen Savers. Refer to the help for
BPC Screen Blanker for more information about BPC Screen Blanker.

There is a check box "Screen Blanker Auto-Run" on the BP checker 2.1 install
display.
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Installing BP checker

@ Start up Windows

@ Insert the program diskette into Drive A.

® Select "File" from the Program Manager menu bar and then "Run...".
For Windows 95, click on the "Start" button and then select "Run...".

@ Type "A:SETUP".

L ] NOTE L ]

Use the appropriate drive specification if the floppy is in a drive other
than Drive A.

® Click on the "OK" button.
(® After a short time, the screen shown in Figure 2-1 will appear.

Battery Performance Checker 2.1 Setup

AKIKUSUINBPC21

Figure 2-1 Installation Screen

HMinstall To

This field specifies the directory in which to install BP checker. The default directory
is C:\KIKUSUNBPC21, but you can install BP checker on any other drive or
directory.

BGPIB Board
Selectable GPIB board is National Instruments NI-488.2 only.
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Setup

B Screen Blanker Auto-Run

When "Screen Blanker Auto-Run" is checked (default)

In this case, Screen Savers is automatically disabled. Your computer will restart after
BP checker 2.1 install, and BPC Screen Blanker will be launched automatically.

When "Screen Blanker Auto-Run" is unchecked

We don't change setting of Screen Savers in your computer. However, note that if
you have set the screen saver, that will not run correctly during the BPC Test
Executive execution.

@ Click on the "Continue" button to start installation.
After installation is complete, the group "Battery Performance Checker" will be
group
created within Program Manager.

BPCSpy  ReadMe

B 2

GPIB BPC Screen Screen
Connection Blanker Blanker Help
Diag

aas aea asa ada ads EY Y
A¥e AVO AYO AYS ALD A¥0
Borland C++ Borland Pascal Microsoft Visual Basic GPIB Software
451 Works 30 Development
Kit.3.1

Figure 2-2 BP checker group




2.3 GPIB Settings for PFX Units

The GPIB address of a PFX40W-08 is set at the factory to "1".

[ 1 NOTE 1

- GPIB addresses are assigned in order beginning from the first PFX
unit. For example, if there are four PFX units, they must be assigned
addresses "1", "2", "3" and "4", respectively. See Figure 2-3.

Changing the GPIB address of PFX unit

O Bring up the display "PFX40W-08" on the panel of the PFX unit.
@ Press [SHIFT] + [1(ADDRESS)] .

(® Set an appropriate address using the number keys.

@ Press [enter] to confirm the new address.

® Pressing [ESC] will return to the "PFX40W-08" display.

(6) The address will change after the PFX unit is restarted.
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2.4 Connecting GPIB Cables

CAUTION

- Be absolutely sure that the power switch of both the PFX unit and the
computer are off before connecting GPIB cables.

Connect the PFX units and the computer by following the steps given below.

(O Turn off the power switch of both the PFX unit and the computer.

(@ Connect one end of the GPIB cable connector to the GPIB board in the computer,
and tighten with fastening screws.

(® Check that an "IB11 (interface board)" has been installed in the option slot on the
rear panel of the PFX unit. If one has not been installed, install one.

@ Connect the other end of the cable referred to in Step (H) to the "IB11", and tighten
with fastening screws.

(® When using multiple PFX units, connect PFX units in series using GPIB cables.
See Figure 2-3.

PFX Unit #4
Address 4

PEX Unit #3
Address 3

PFXUnit #2
Address 2

PEXUnit #1
Address 1

Computer

Figure 2-3 Four-Unit PFX System

What to do Next

Continue on to Chapter 3, and make all necessary system environment settings and
test condition settings.
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CHAPTER 3
CONFIGURING THE SYSTEM -
PFX Config

This chapter describes environment settings for the entire system rack and how to
set common items for each unit. After these descriptions, it explains how to create
management files and how to transfer data to the PFX40W-08 units.

Sections in Chapter 3

3.1 Starting PFX Config
3.2 System Configuration
3.3 Unit Configuration
3.4 Sending Set Data
3.5 Quitting PFX Config
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3.1 Starting PFX Config

To execute PFX Config, double-click on the "PFX Config" icon.

Program Manager
File Options Window Help

§

Battery Performance Checker
BPCSpy  ReadMe

Double-click here

GIB BPC Screen Screen
Connection Blanker Blanker Help
Diag

aea aaa aas| aea eaa aea
Ag® A¥D 420 A¥D A¥G A¥e
Borland C++ Borland Pascal Microsoft Visual Basic GPIB Software
451 Works 30 Development
Kit 31

Figure 3-1 Starting PFX Config

The PFX Config screen will appear, and the current setting status for each unit will
be visible.

UNIT1.SET ‘ B channsls
UNIT2.SET (unused)

: (unused)
UNIT3.SET (unused)

Paste unit data

{(unused)
(unused)

Copy unit data

Configure overall
rack system

End all testing currently Send data to PFX
executing (all units/all units
channels)

Figure 3-2 PFX Config Screen
Note that the screen shown here is for unit settings managed by BP checker. Since

data set here has not yet been sent to PFX units, it does not reflect the actual current
status of units.
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[Unit#] represents a serial number assigned according to the number of units
connected.

"(unused)" is displayed for unused units (Unit 2 and beyond in this example).

L 1] NOTE 1 J

- To ensure that tests are always conducted under proper conditions,
we recommend that PFX Config be executed to send setting values
to PFX units and then terminated every time the system is started (at
power on) even if no settings have been changed. This procedure
allows confirmation of system configuration and checking of
communications status, and allows BP checker management files to
be matched to PFX40W-08 units.

3.2 System Configuration

- Double-clicking on "System Configuration' will cause a system configuration screen
such as the following to appear.

Figure 3-3 System Configuration Screen

The operation mode and the number of PFX units in the system can be changed from
this screen.

System configuration items

M Selecting the operation mode

BP checker includes two operating modes: sequence mode and life cycle mode. You
can use the "Operation Mode" select switch to select either mode. Each of these
operation modes is described below.
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|Sequence

Sequence Mode

Select this mode when you wish to test the initial characteristics of your batteries.
Tests are conducted by changing charge and discharge settings every time (or every
set number of times). Graph data files (including voltage, current, and temperature
transition) can be created for each charge and discharge.

Life Cycle Mode

Select this mode when you wish to test the life characteristics of your batteries. Tests
are conducted for items which can be set for the PFX40W-08. Result files can be
created for each full charge and full discharge. Result files regarding life
characteristics can also be created when all tests are completed.

M Selecting the number of units

Select the number of PFX units being controlled from the "Number of Units' list. 1 to
6 units can be selected.

When settings are complete

Click on the "OK" button to confirm current settings.

3.3 Unit Configuration

Select the desired unit number from the list box and click on the "Edit" button when
you wish to check or change detailed settings for each PFX unit. Then, a "Unit
Configuration" screen will appear.

PFX Configuration

List box {unused)

(unused)
{(unused)
{(unused)
(unused)

Figure 3-4 PFX Configuration Screen
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- The items "Cycle Format" and "Synchronous Operation" found on
this screen are disabled (grayed out) when sequence mode is
selected.

Only in life
cycle mode

Only in life
cycle mode

Figure 3-5 Unit Configuration Screen
This screen represents when Unit #1 has been selected.

These are some of the testing conditions which can be set. You can set these items
separately for each unit. These items must be set before tests are actually conducted.
For details on each setting item, see the operation manual for the PFX40W-08. A
brief description of these items is given here.

Unit setting items

B Test Environment

Range

This indicates the voltage/current range and the number of channels connected in
parallel. The default number of channels is 8, but when connections are in parallel,
select 4, 2 or 1 depending on the combinations used. Current range is determined
based on the voltage range and number of channels. Select any of the following from
the 8 settings shown below.

1 channel / 10V-32A 1 channel / 20V-16A

2 channels / 10V-16A 2 channels / 20V-8A
4 channels / 10V-8A 4 channels / 20V-4A

8 channels / 10V-4A 8 channels / 20V-2A
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Life

cycle

Measure Temperature

This specifies whether or not to measure battery temperature. This can only be
selected when a thermistor is actually connected to a battery.

Synchronize

Select this item when synchronizing test cycles between channels. Synchronous
Operation, described later, must also be set when this item has been selected.

BCycle Format

L 1 NOTE o 1

- This setting is disabled (grayed out) in sequence mode.

Max cycle

Interval

Cycle Charge Full Charge

Cycle Discharge Full Discharge

Time

Figure 3-6 Number of Cycles and Interval

Max Cycle

One charge and discharge is counted as one cycle. This item sets the maximum
number of cycles, including cycle charge/discharge and full charge/discharge, for the
entire test The Max Cycle setting in the figure above is 7.

Interval

This is the interval between cycle charge/discharge and full charge/discharge. The
Interval setting in the figure above is 3 cycle charge/discharges and one full charge/
discharge for an Interval of 4.

Judgment Margin

This is the margin value for judging if a battery passes or fails. In other words, it is the
upper limit of the capacity rate factor (%) used to determine a pass. The actual
capacity value is judged as okay or no good in relation to the capacity rate set under
testing conditions.

Configuring The System



Life
cycle

Judgment Count

This setting is used to terminate charge/discharge cycle testing once the measured
capacity of a battery has tested as no good a certain number of times thus indicating
that its life has expired. Under this condition, testing may end before Max Cycle is
reached.

Recharge Finally

Select this item when you wish to recharge your batteries after all testings are
complete.

B Synchronous Operation

= 1 NOTE 1

This setting is disabled (grayed out) in sequence mode.

Be sure to set various synchronization times when you have selected Synchronize
under Test Environment. If Synchronize has not been selected, synchronization
times are disabled (grayed out).

BMemo

A memo of up to 20 characters in length can be input to each unit.

When settings are complete

Click on the "OK" button to confirm current settings. The contents of the table will be
updated to reflect current settings.

"Copy" and "Paste"”

Use these functions when you wish to use the same settings for multiple units. These
functions are available when more than one PFX unit is being used.
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PFX Configuration

{(unused)
{unused)
{unused)
(unused)

Figure 3-7 PFX Configuration Screen

You can send configuration settings to each PFX unit when the PFX Config is
complete. If you wish to send data without quitting, click on the "Send" button on this
screen. All settings up to this point will be sent to each PFX unit. Data transfer has
failed if any of the following error messages appear. If this happens, follow the given
instructions.

BERR-220

Cannot open GPIB device. Please check GPIB adapter and driver
configuration.

This error message appears when the device driver set under the system
configuration differs from the actual GPIB board being used, or when the driver for
the GPIB board has not been loaded properly. Send data again after correcting
settings for the driver.

BMERR-230

GPIB write error in Unit x - Address x. Please check GPIB addresses and
cables.

This abnormal communications error message appears when there are units among
those displayed which are not GPIB connected. Check connections and Retry.

BMERR-301
Cannot change the PFX operation mode to SETUP mode.

This warning message appears when there is an executing channel (including HOLD
and END status) among those units displayed. Execute "Quit All Channels",
described next, if this happens.
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Quit all channels

If the error message ERR-301 appears, and you wish to quit all currently executing
tests (abandon testing, STOP & QUIT) but still wish to send data, close this warning
message and select ""Quit All Channels" on the PFX Configuration screen.

Click on the "Yes' button when the confirmation message box appears. Note that if
you select this accidentally, important testings may be abandoned before they are
finished.

Figure 3-8 Confirmation Message

3.5 Quitting PFX Config

You can quit PFX Config by selecting "Close" from the control menu box in the
upper left of the screen. A message box will appear asking if set data should be sent
to each unit. If testing is to be conducted, select '"Yes'" to send the data.

PFX Configuration

Figure 3-9 Send Message

. 1 NOTE o )

- Normally data is sent when quitting PFX Config. Avoid sending data
before quitting. Note that data is not sent when PFX Config is
iconized.
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If the transfer is failed, an error message will appear. If this happens, follow the
instructions given in the previous section "Sending Set Data". Do not conduct testing
when there are errors sending data or without quitting PFX Config (without sending
data). There is no way to send system configuration data and unit configuration data
to PFX units except using PFX Config.

When you quit PFX Config, the configuration data will be overwritten to PFX
configuration files.

Unit Configuration

C:\KIKUSUI\BPC21\UNIT1.SET
C:\KIKUSUI\BPC21\UNIT2.SET

C:\KIKUSUI\BPC21\UNIT6.SET
(Six files are created corresponding to the serial number of each unit.)

If BP checker has been installed in another drive and/or directory, you can find
these configuration files there.

These files are written whenever you exit PFX Config regardless of whether or not
data was sent at that time. These files are always required when executing BP
checker. If any of these files do not exist, operations will be conducted using all
default values. Normal operations are impossible if you execute tests when PFX units
do not match associated file contents.

To ensure that tests are always conducted under proper conditions, we recommend
that you execute PFX Config and then send setting values to PFX units when every
time you start the system (at power on) even if no settings have been changed. This
procedure allows confirmation of system configuration and checking of
communications status, and allows BP checker management files to be matched to
PFX40W-08 units.

What to do Next

Continue on to Chapter 4, and create all folders and worksheets necessary for actual
testing.

Configuring The System




CHAPTER 4
CREATING AND MANAGING
TEST CONDITIONS -

Folder Editor

This chapter describes the Folder Editor and then explains how to create folders and
worksheets.

Sections in Chapter 4

4.1 Folder Editor

4.2 Starting the Folder Editor
4.3 Creating Folders

4.4 Creating Worksheets

4.5 Saving Folders
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4.1 Folder Editor

The Folder Editor is a program for editing folders and multiple worksheets contained
within folders.

A folder is a collection of worksheets which describe how tests are to be conducted.
A worksheet represents a test scenario including charge current, discharge current,
time, and other factors. Battery information shared by all worksheets and header
information for managing the entire collection of
worksheets is included in a folder.

Each PFX40W-08 unit can have up to 8
worksheets at once. Under BP checker, this
means each folder can handle up to 99
worksheets.

Worksheet #1

How worksheets are handled differs slightly
depending on the operation mode of BP checker.
Figure 4-1 Folder In life cycle mode, worksheets for battery life
characteristics are used to conduct separate tests
numerous times based on given test conditions. In sequence mode, it is necessary to
investigate a battery's initial charge characteristics. It is therefore necessary to keep
on successively changing to different test conditions (worksheets). In this case,
worksheets must be properly ordered in order for successive testing.

It is useful to think of a folder as a heading, and worksheets as separate elements.
Note however that all worksheets in a folder have been created for the same battery.
This means the three items of information, battery type, nominal voltage, and
nominal current, represent "battery information" shared throughout the folder. Each
of these items can only be set once within a given folder.

For details on the concept and contents of worksheets, please refer to your PEX40W-
08 operation manual.

Same data

Battery Information

Worksheet File (99 Files Max.)
Figure 4-2 Battery Information and Worksheet Files
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4.2 Starting Folder Editor

To start the Folder Editor, double-click on the "Folder Editor" icon.

Program Manager

Read Me

Double-click here

E 2

GPIB BPC Screen Screen
Connection Blanker Blanker Help

Borland C++ Borland Pascal  Microsoft Visual Basic GPIB Software
; 451 Works 30 Development
Kit 31

Figure 4-3 Starting the Folder Editor

If you are going to actually conduct tests, assign any folder to a given channel, select
the desired worksheets from within the folder, and execute.

The Folder Editor is used for editing the test contents of worksheets and creating
folders in which to save those worksheets.

4.3 Creating Folders

There are two ways to create a folder: create a new one, or change an existing one.
The Folder Editor allows you to create a new folder immediately after it has been
started. You can create a new folder from scratch, or you can select ""Open" from the
"File" menu and load an existing folder.

The file name of a folder must follow MS-DOS conventions. It may consist of up to
8 letters. The extension must be "FLD" when in life cycle mode or "FSQ" when in
sequence mode.
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Setting battery information

The first thing you must do when setting test conditions (writing conditions to a
worksheet) is set battery information. Battery information is shared throughout a
folder by all worksheets. Once these settings have been made, you can begin
inserting several worksheets, but you should first secure a place (a drive and
directory) in which to save your folder. A folder containing one worksheet requires
approximately 3 KB of disk space to save.

A dialog box for setting battery information will appear when you select '"Battery
Info..." from "Edit" on the menu bar.

Folder Editor - Untitled
| File 10
Cut Shift+Del [faREs
Copy Ctrltins
Paste Shift+lns
Delete Ctrl+Del
Insert Ins

Battery lnfa...
Worksheet...

Figure 4-4 Setting Battery Information

channels /7 20V-2A

Figure 4-5 Battery Information Dialog Box

HEMemo

This is a memo for this folder. You can freely enter up to 20 characters.
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M Battery Type

This data is treated as a comment. Information entered here does not effect testing,
but is sent to the PFX unit. Choose a battery type from the list or enter a descriptive
name (up to 10 characters). The default is Ni-Cd.

. 1 NOTE o )

- When reading folders created under BP checker Ver 1.0, battery
type is displayed as a number from 1 to 4. These numbers represent
battery type as indicated below. Although using these numbers for
the battery type represents no problem whatsoever in terms of actual
testing, you can change them by selecting from the list if you want
battery type represented by a descriptive name.

1:N-Cd 3:Pb
2:Ni-MH 4:Li

MNominal Voltage, Capacity Rate

These values directly effect testing conditions. Valid values must be input.

BRange

This setting is used to check the range for voltage and current when creating
worksheets. The range data actually sent to the PFX units is that set for the system
configuration using PFX Config. If the folder used for testing has a range other than
that set under PFX Config, a warning message will be displayed, but testing will still
be possible. The reason for this is that it is conceivable that testing may be performed
on a battery with different unit settings such as when a single folder is used for
multiple channels. This means that when testing is being conducted using a folder for
which a warning message is displayed, you must manage condition setting values
yourself. Also, since a range check is performed only when the window for each
worksheet is closed, no range check is performed right when the value under the
folder heading "Range' is changed when writing worksheets. If you want the range to
be checked, try opening/closing all setting windows active for the worksheet in
question. If an inappropriate range has been specified, the associated window will
not close.

Folder settings are complete when you select "OK" setting these items. Be sure to
save settings before you forget. To save, select ""Save'" or "Save As'' from "File" on
the menu bar. The file name extension will be set by default to "FLD" (life cycle
mode) or "FSQ" (sequence mode). Although you may freely select the directory and
file name, do not change the extension. The file name of the folder just created
appears on the title bar of the associated window.
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4.4 Creating Worksheets

Setting battery information is not enough to conduct testing. You must also create a
worksheet and set necessary test conditions there too. This section describes how to
create a worksheet and make necessary settings within.

Creating a worksheet

To create a worksheet, select ""Insert” from "Edit" on the menu bar. Then a single line
including numbers appears on the Folder Editor. This is a worksheet. Try repeating
the same operation one more time. The display now shows two lines. Each line
represents a worksheet. Next, click on one of the two lines on the Folder Editor. The
line selected will highlight and indicate that the worksheet is selected. Now let's
explain how to make settings in a worksheet.

Folder Editor - Untitled

Edit
sy Cut Shift+Del
Copy Ctrl+Ins
Paste Shift+ins
Delete Ctrl+Del

Battery Info...
Worksheet...

Figure 4-6 Creating a Worksheet

Select either of the two worksheets you just created. Now select "Worksheet..." from
"Edit" on the menu bar or double click on the worksheet in question.
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Cut Shift+Del
Copy Ctritins

Paste Shifttlns

L

Delete Ctrl+Del
Insert Ins

Battery Info...
Warksheet...

Figure 4-7 Editing a Worksheet
A dialog box entitled Worksheet #x (where x is the worksheet number) will appear as

the worksheet setting screen. This screen differs depending on the operation mode.

Waorksheet #1

|Sequence

Figure 4-8a Worksheet Setting Screen in Sequence Mode
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Worksheet #2

Figure 4-8b Worksheet Setting Screen in Life Cycle Mode

M Battery Type, Nominal Voltage, Capacity Rate

Battery information which has already been set (battery type, nominal voltage, and
capacity rate) is shown here for confirmation purposes.

BMemo

A user-defined comment of up to 20 characters can be entered here.

BMCycles

L ] NOTE L J
Sequence
IJ-—> - This setting is not available in life cycle mode.

This setting specifies how many times this worksheet is to be repeated when tests are
conducted in sequence mode.

BCycle Charge/Discharge

[ 1 NOTE 1

- The operation performed when the Charge or Discharge buttons are
pressed differs depending on which item in the list to the immediate
right (charge/discharge mode) is selected.
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Setting charge/discharge mode

- If the "Cycle Format/Interval" of the unit configuration under PFX
Config is set to "1", these settings are not needed since "Cycle
Charge" and "Cycle Discharge" will not be executed. Similarly, the
"Init Charge" setting is not required when initial charge is not
performed.

Life
cycle

Setting charge/discharge parameters

Before setting charge/discharge parameters, it is necessary to select the charge/
discharge mode. This is because parameter contents differ depending on the charge/
discharge mode selected. Select the desired charge/discharge mode from the list
immediately to the right of the Charge or Discharge buttons.

B Cycle Charge/Discharge Mode

L 1 NOTE 1

- This setting is not available in sequence mode.

There are four modes which can be set for the charge mode: "CC", "CC-CV", "CC-
Pattern", and "CC-CV-Pattern". There are four modes which can be set for the
discharge mode: "CC", "CP", "CC-Pattern", and "CP-Pattern"’.

For details on these settings, please see your PEX40W-08 operation manual.

BFull Charge/Discharge Mode

There are two modes which can be set for the charge mode: "CC" and "CC-CV".
There are two modes which can be set for the discharge mode: "CC'" and ""CP".

For details on these settings, please see your PFX40W-08 operation manual.

Once you have selected the charge/discharge mode, you can finally enter specific
values for charge/discharge parameters. When you press the Charge or Discharge
button arranged on the left, an edit screen for each parameter will appear. The edit
screen which appears will depend on the charge/discharge mode you have selected.

L | | NOTE 1 J

- For each of the dialog boxes shown from Figure 4-9 through 4-25,
any value entered beyond the decimal point will be ignored for
settings which are normally taken as integers.
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BCycle Charge

\ 1 NOTE ¢ 1

- This setting is not available in sequence mode.

There are six different setting screens possible depending on the charge mode. These
are shown in Figures 4-9 through 4-14.

Cycle Charge

Figure 4-9 Cycle Charge Screen when CC Mode is Selected

Figure 4-10 Cycle Charge Screen when CC-CV Mode is Selected
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Figure 4-12 Step Setting Screen when CC-Pattern Mode is Selected

Figure 4-13 Cycle Charge Screen when CC-CV-Pattern Mode is Selected
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Figure 4-14 Step Setting Screen when CC-CV-Pattern Mode is Selected

BCycle Discharge

[ 1 NOTE ¢ 1

- This setting is not available in sequence mode.

There are six different setting screens possible depending on the discharge mode.
These are shown in Figures 4-15 through 4-20.

Figure 4-15 Cycle Discharge Screen when CC Mode is Selected
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Cycle Discharge

Figure 4-16 Cycle Discharge Screen when CP Mode is Selected

Figure 4-17 Cycle Discharge Screen when CC-Pattern Mode is Selected

0
0
0
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0
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0

Figure 4-18 Step Setting Screen when CC-Pattern Mode is Selected
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4-14

ycle Discharge

Figure 4-19 Cycle Discharge Screen when CP-Pattern Mode is Selected

Cycle Discharge [CP-Pattern)

0
0
0
0
0
o
0
0
0
0
0
0

Figure 4-20 Step Setting Screen when CP-Pattern Mode is Selected
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BFull Charge

There are two different setting screens possible depending on the charge mode.
These are shown in Figures 4-21 and 4-22.

Figure 4-21 Full Charge Screen when CC Mode is Selected

Figure 4-22 Full Charge Screen when CC-CV Mode is Selected
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MFull Discharge

There are two different setting screens possible depending on the discharge mode.
These are shown in Figures 4-23 and 4-24.

Figure 4-23 Full Discharge Screen when CC Mode is Selected

ull Discharge

Figure 4-24 Full Discharge Screen when CP Mode is Selected
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L ] NOTE | ]

- This setting is not available in sequence mode.

Initial Charg

CH-H-H-H-H-H-H-H-H-H-H-H-}H-]
CH-H-H-H-E- R H- - H-H-H- )

CC D000 D000 O

Figure 4-25 Initial Charge Setting Screen

Saving worksheets

Once each item has been set, click on "OK" on the worksheet dialog to confirm
worksheet contents. The comment text entered in the Memo field will appear at the
left of each worksheet entry.

Also, a reference value for the total time for cycle charge/discharge (shallow charge/
discharge) and full charge/discharge (deep charge/discharge) during normal
operations will be displayed. (For "Cycle" and "Full" entries.)

Folder Editor - Untitled

BPChecker Temt—o B e

Figure 4-26 List of Worksheets
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Editing worksheets

You can do various operations from "Edit" on the menu bar of the Folder Editor for
use inside worksheets. These operations include: Cut, Copy, Paste, Delete, and
Insert. Cut & Paste and Copy & Paste can be used within the same folder or between
worksheets of different folders when creating a new folder or opening existing
folder.

4.5 Saving Folders

4-18

To save a folder, select ""Save" or "Save As' from "File'" on the menu bar. The file
name extension will be set by default to "FLD" (life cycle mode) or "FSQ'" (sequence
mode). Although the you may freely select the directory and file name, do not change
the extension. The file name of the folder just created appears on the title bar of the
associated window.

Worksheets are saved in their own files once the folder is saved. The file name of
each worksheet in a folder is the same as the associated folder, but with an extension
from WO1 to W99.

[ 1 NOTE o 1

- Although the extension used in the file name of a folder differs
depending on whether it is intended for sequence mode or life cycle
mode, the extensions of worksheet files underneath a given folder
are always the same. To avoid conflicts in file names in sequence
mode and life cycle mode, be sure to save folders for different
modes in different directories. The directories LIFE and SEQ are
already created for you underneath C:\BPCHKR.

What to do Next

Continue on to Chapter 5, and conduct actual tests using folders and worksheets
created in this chapter.
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CHAPTER 5
CONDUCTING TESTS -

Test Executive

This chapter will describe how to conduct tests and interpret the test screen.
Sections in Chapter 5

5.1 Starting Test Executive

5.2 Conducting Tests Using Different Worksheets for Each Channel

5.3 Conducting Tests on More than One Channel Using One Worksheet
5.4 Functions Related to the On-Screen Display

5.5 Options

5.6 Processing During Power Failures
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5.1 Starting Test Executive

Test Executive is the kernel program for the BP checker and manages actual testing.
It executes for each channel, monitors test status, and automatically creates results
files. The main feature of Test Executive is communication with PFX units.

[ 1y NOTE ]

Although it depends on the number of units connected, in terms of
time required for communications, there is an adverse effect on the
speed of other applications run while tests are being executed by
this program. Avoid running or using other applications as much as
possible while this program is conducting tests. This is necessary so
that important data is not missed.

To execute Test Executive, double-click on the "Test Executive" icon.

Program Manager

Double-click here
GPIB BPC Scren Screen
Connection Blanker Blanker Help
Diag
aea aas faea aas feeal aea
A¥D A¥B ACQ A¥O AvD Ave
Boiland C++ Borland Pascal Microsoft Visual Basic GPIB Software

4.51 Waorks 30 Development

Kit 3.1

Figure 5-1 Starting Test Executive

When Test Executive is started, the entire system environment is read in from PFX
configuration files. The data is read in from files, not from PFX units. Normal
operations are not possible if there are any differences between PFX units and
contents of configuration files. If you think that there are any differences quit Test
Executive, start PFX Config and then restart Test Executive after checking PFX unit
settings. For details, see Chapter 3, "Configuring the System - PFX Config".
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B Channels

The execution unit of this program is a channel. Channels have a one-to-one
correspondence with individual batteries being tested. For example, if there are eight
batteries to be tested, then there are also eight channels. Each channel has a
corresponding "channel window" during testing.

It is necessary to first open a channel when starting testing. A folder must be assigned
to that channel at this time. Usually this is done when a channel is newly opened.
However, sometimes you may want to test several same type batteries under the
same conditions. In such cases, it is possible to assign a single folder to more than one
channel.

5.2 Conducting Tests Using Different Work-
sheets for Each Channel

Opening a channel

Let's open a channel. You can open the "Channel Open'" dialog box by either
selecting ""Open' from ""Channel" on the menu bar, or by pressing the "Open" button
on the toolbar. Here, we will select the channel on which we want to conduct testing.

BPC Test Executive
Menu bar h.Channel Test Group Options Window Help

Toolbar

Figure 5-2 Opening a Channel
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Figure 5-3 Channel Open Screen

Since we are going to conduct testing by assigning a different worksheet to each
channel, select "Individual" from the list under "Folder Assignment”. (This is
selected by default.) Afterwards, select a unit number and a channel to be tested, and
confirm by pressing "OK". This will cause the "Run Condition" dialog box of the
target channel to open.

Run Condition - Uni Channel 8

C:ADATA\DATA 18

Figure 5-4 Setting Run Conditions

Setting run conditions

This dialog box is used to set necessary conditions before conducting testing. Items
are roughly divided into the following two sorts:

® Reading folders
m  Settings related to the automatic creation of test results files
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[Seguence

MReading folders

Here, a folder assigned to the channel has to be read in. Find the folder by its file
name. In life cycle mode, the extension of the file will be "FLD", while in sequence
mode it will be "FSQ". Also, in life cycle mode, you also have to select a desired
worksheet that will be used as test conditions. Since worksheets are sequentially used
from the first when in sequence mode, you don't have to select any worksheet.

To read a folder, first press the ""Open Folder' button to open a folder created with the
Folder Editor. If the folder read in does not include even one worksheet, it will not be
possible to open a channel. In this case, the "OK" button will be grayed out and
cannot be selected. You can close the channel window by pressing the "Cancel"
button. Next, stop working in Test Executive (or iconize it) and start the Folder
Editor. Try opening a channel window again after you have created a folder and
associated worksheets. You can quit Test Executive since testing will not be
conducted at this time anyway. (Of course you can close it too.)

The "Folder" portion at the top of the screen is determined by opening a folder.

In life cycle mode, you have to select the desired worksheet from the folder. A list of
worksheets will appear in the "Worksheet List". Select one of the worksheets shown.

In sequence mode, since worksheets in a folder will be sequentially used from the
first, you cannot select a worksheet from the list.

B Settings related to automatic creation of test results files

Here, you set the location in which to save test results files, whether or not to create
them, and interval for them.

Settings directory in which results files are created

BP checker creates many test results files from the test results of a given channel. The
names of these files are automatically determined by the BP checker system.
However, since the same result file names will be assigned on each separate channel,
it is necessary to assign different directories to different channels. In actual practice,
this means you need 48 different directories for testing on 48 different channels.

These directories should all be located within the same base directory on the same
hard disk drive. The base directory should be at the top of the directory tree, with
subdirectories for saving data for each channel beneath it. For example, if the base
directory is C:\DATA, and the subdirectory for Channel 1 is DATA.11, all test result
files for Channel 1 will be placed in the directory C\DATA\DATA.11.

The base directory is set to C\DATA as default. And the subdirectory for each
channel is DATA.XX, where XX stands for the corresponding unit number and
channel number. For example, if testing is for Unit 1 on Channel 8, the corresponding
subdirectory is DATA.18. There is no problem using default directories just by
changing the base directory for each testing project. If you still want to change
directory specifications, change it using the '"Data Directory Path" item.
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L 1 NOTE )

- If there is old test data remaining in a data directory, it will be
overwritten by new data. If you don't want to lose old test data,
change the setting for the base directory. A confirmation message
asking you to check the directory name will appear every time you
start Test Executive or set the base directory.

To change the base directory at a later time, select "Data Directory"
from the "Options" menu within Test Executive.

Whether or not to create results files

You can individually specify which types of graphs should be created using the
check boxes showing the eight graph types available. After testing has completed,
graphs and tables can be created and printed from within the BPC Graph program by
opening those files which have been created.

Files created here are always in binary format so that the large amounts of data can be
processed quickly. If you need text format files, use the "Save in text format"
function of the BPC Graph program.

Charge Graphs, Discharge Graphs

Graph data files for each charge/discharge characteristic are created whenever a full
charge or full discharge is completed. Graph data files for both charge and discharge
include those for voltage, current, and temperature characteristics. The letters given
in brackets below represent file name extensions used for each of these file types.

[.GCV] Charge test voltage graph data file

[.GCC] Charge test current graph data file

[.GCT] Charge test temperature graph data file

[.GDV] Discharge test voltage graph data file

[.GDC] Discharge test current graph data file

[.GDT] Discharge test temperature graph data file
Here, we will give a brief description about each of the types of files created. The
names of files created consist of a 5-digit number representing the test cycle number.

Example: 00005.GDV (Discharge test voltage file for the 5th cycle)

Life Graphs

These files are for creating graphs related to life characteristics. The two files listed
below are created for each test.

LIFE.GCL (Charge life characteristics results file)
LIFE.GDL (Discharge life characteristics results file))
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Report files

Although not displayed on the dialog boxes listed in the Run Conditions screen, the
two files listed below are also created for use of creation of charge/discharge
characteristics lists.

RSLTCHG.REP (Charge life characteristics results report file)
RSLTDCHG.REP (Discharge life characteristics results report file)
These files can be used under BPC Graph to create reports relating to charge and
discharge characteristics. These report files are always created and cannot be
disabled.

Interval for results file creation

The text boxes found under the heading "Interval" under both "Charge Graphs'' and
"Discharge Graphs" are used to set the interval at which each file type is to be
created. This is used when you do not need results files for every test cycle, but do
want results files every given number of cycles. Regardless of the numeric value
appearing here, files will be created for the first cycle and last cycle of a test if file
creation has been selected.

Once a folder and worksheets have been selected and settings regarding results files
have been made, clicking on the "OK" button will cause window for the associated
channel to appear.

If you wish to re-display the Run Conditions dialog box for a channel which is
already open, activate the channel's window, and select "Running Condition' from
under "Channel" on the menu bar. Note that once testing has begun, this can only be
used to check run conditions, not change them.

[ 1 NOTE 1

If the cycle format setting of the PFX unit associated with the channel
for which testing is being conducted is not "Interval=1", in other
words if cycle charge or discharge is being conducted, the graph
interval will be fixed at 1 (create graphs every cycle) and this setting
cannot be changed.

Executing tests (Run)

Now let's actually execute a test. If you have followed the steps described so far,
executing a test should be simple. Please note however that testing will not execute
properly if no battery is connected or if test condition settings are not appropriate for
the battery type which is connected.
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BPC Test Executive
Channel Test Group Options Window Help

Unit 1 : Channel 8

Figure 5-5 Executing Tests

Select the window of the channel for which you wish to conduct testing. The toolbar
includes the channel open button and buttons for other frequently used test execution
commands. Buttons which are not currently active are grayed out and cannot be
selected. Active commands for the selected channel can also be found under "Test"
on the menu bar. Selecting "Run" will cause test execution to start. Try executing a
test. The display will not change until the status monitoring begins. But after a while,
execution status monitoring will begin. The command button active at this time will
change from "Run" to "Stop".

BPC Test Executive o
Channel Test Group Options Window Help
Unit 1 : Channel 8 . v

i Full Discharge
Volt 1.318V i Temp: 6.4'C
i Curr: -0.760A Elapsed 0:00:55

’ Voltage [V ]

2[]_1

16 4

12
8
4

0 f

15
Voltage Transition Time [ min ]
Full Charge

Figure 5-6 During Test Execution
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A graph will be displayed in the window once a full charge has been completed. The
graph type can be changed by clicking the right mouse button on the graph. However
immediately after testing begins, this will result in "No Graph". If no graph data is
found, "Graph Data Missing" will be displayed.

BPC Test Executive
Channel Test Group Options Window Help

Unit 1 : Channel 8

Cycle - i End
Volt: 0.000V i Temp: 0.0°C
Curr: 0.000A Life Test NG 1
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Figure 5-7 Changing Graphs

Using commands on the "Test" menu or buttons on the toolbar, you can execute, halt,
restart and stop tests on separate channels. Operations are possible on any channels
whose windows are currently active.

The "Group" menu can be used to start/stop the execution of testing all at once for all
channels in the system. Pay particular attention to four of these items: "Run/
Continue", "InitRun/Continue'", "Stop', and "Quit". Selecting "Stop" puts all
channels for which testing is being conducted in HOLD status. "Run/Continue"
issues a "Run" command to all channels currently in IDLE status, and issues a
"Continue' command for all channels currently in HOLD status. "Quit" terminates
all testing and puts all channels in IDLE status.
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Figure 5-8 Test Menu
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Figure 5-9 Group Menu
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Setting the timer

During test execution, status is always monitored at a constant interval based on a
timer. It is needed for that current status is displayed on the window. The system
checks status change with status monitoring and performs any necessary processing.
For example, if a full charge or full discharge has ended, graph data must be read
from the PFX unit. This status monitoring is performed for every channel on which
testing is being conducted (except those in IDLE status). Typically the response of
other Windows operations slows down when there is a lot of this processing. It is
therefore possible to set the timer speed slower if you wish to preserve quick
response of operability even though timer interval is going to slower.

You can set the timer by selecting "Timer Tick Setup" from "Options" on the menu
bar, or by clicking on the "Timer" button on the tool bar.

BPC Test Executive

Channel Test Group Qpiiuns Window Help
= =R Dotz Dircctoy-— | o

Cycle - Timer Tick Setup...

Volt: 0.000v [ Preferences...
Curr; 0.000A TLNe TEStTNO T
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16 4
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8
4

0 ;
15
Yoltage Transition Time [ min ]
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Figure 5-10 Changing Timer Speed

Timer Tick Setup

secon
3 seconds

seconds
10 seconds

Figure 5-11 Timer Tick Setup Screen
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Any of the following values can be selected as the timer speed: 1 second, 3 seconds,
5 seconds, 10 seconds, 30 seconds, or 60 seconds. However, even if you have
selected a fast timer, data acquisition and status monitoring will take precedence
when there are many channels on which testing is being performed. This means that
sometimes the status monitoring interval will be longer than the set value. For
example, although status monitoring can be done every second for four channels, the
actual interval will be longer than one second for more channels. Use the timer speed
setting to improve Windows response and operability even though the monitoring
interval becomes longer.

B Selecting timer tick and limitations on charge/discharge times

The timer tick setting is used to set the time interval for status monitoring on
executing channels. It is necessary to set the optimum timer tick depending on the
number of channels. If the timer tick is too short operability will worsen, but if it is
too long, graph data may not be acquired properly.

The full charge/full discharge time is limited by whether or not graph data is being
acquired and how many channels are executing. Note that graph data may not be
acquired properly when a full charge/full discharge is performed in a shorter time
than the limit.

For details on charge/discharge time settings and data acquisition failure, see the
separate document "Performance Limitations".

L 1 NOTE ¢ 1

Please consult Kikusui agent when you need to set a full charge/full
discharge time even shorter than the minimum time.

5.3 Conducting Tests on More than

Opening channels

One Channel Using One Worksheet

When you wish to test more than one battery of the same type under the same
conditions, it is inefficient to assign one folder/worksheet separately for each
channel. Test Executive allows you to assign the same folder to multiple channels for
conducting tests. This is a useful method for executing tests since you do not need to
set folders for each channel.

5-12

Let's open a channel. Either select ""Open" from "Channel" on the menu bar, or press
the open button on the toolbar to open the "Channel Open' dialog box.
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Channel Open

Figure 5-12 Channel Open Dialog Box

There are two ways to select multiple channels: unit-collective and system-
collective. Select '""Unit-collective” when you wish to use the same test conditions
within a particular PFX unit. Select "System-collective” when you wish to use the
same test conditions throughout the entire PFX rack system.

Figure 5-13 Setting Run Conditions (System-Collective)

Operations from this point until test execution are the same as those described in
Section 5.2, "Conducting Tests Using Different Worksheets for Each Channel".
Please refer to that section for details.

L 1 NOTE )

If more than one channel window is open, "System-collective" and
"Unit-collective" for the PFX unit to which the channel belongs
cannot be selected. Also, when collective execution is used the
"Data Directory Path" setting cannot be made.
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5.4 Functions Related to the On-Screen
Display

5-14

B Channel windows

Each PFX channel has a one-to-one correspondence to a window called a channel
window. The unit number and channel number associated with each window is
displayed on its title bar.

The channel windows don't have to be visible during testing. Iconizing a channel
window has no effect on test execution. However, it is not possible to close a channel
window during testing, because that would result in testing for that channel being
abandoned. The only time a channel window can be closed is when that channel is
offline (no communications). Any attempt to close a channel window while it is
online will simply result in that window being iconized.

You can open the monitor window to identify which channels are online or offline.
This is described next. The status line at the bottom of the screen always displays
"ONLINE" when communication with one or more channels are being performed.
Note that this indication cannot be used to identify which specific channels are
currently online.

BMonitor window

When the number of executing channels has become large, the monitor window is
useful for overseeing all testing. This window can be displayed by selecting
"Monitor" from the "Window" menu, or by clicking on the ""Mon" button on the
toolbar.

The status of each channel is summarized on the monitor window. Also, double-
clicking on any of the channels on the monitor window will cause corresponding
channel window to be brought to the top.

"OFFLINE" is displayed for channels for which no testing or monitoring is being
conducted. When the channel window of a channel which is offline is closed, you
will have to reassign a folder for the channel to reopen it.
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Figure 5-14 Selecting the Monitor Window

BPC Test Executive
Channel Test Group Options Window Help

yele End
Volt: 0.000v Temp: 0.0°C
Curr: 0.0004 Life Test NG 1
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Figure 5-15 Monitor Window
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M Tile display and cascade display

When there are many windows or icons on the display, the "Window" menu can be
useful in organizing them. Monitoring will be performed even for open channel

windows which have been iconized.

Channel

Group Options

Figure 5-16 Selecting a Tile Display or Cascade Display
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Figure 5-17 Tile Display

BPC Test Executive
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Figure 5-18 Cascade Display
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5.5 Options

Test Executive includes other optional functions for setting the environment. To set
optional functions, select "Preferences' from under "Options" on the menu bar.
These preferences will be saved automatically when you exit BP checker.

Charge: Voltage

Figure 5-19 Setting Preferences

M Default Downloading

This item sets default values for which graphs are to be generated as set on the Run
Condition dialog box. All graphs are selected for generation by default immediately
after BP checker is installed.

M Default Preview

This item sets a default type of graphs to be displayed on the channel window.
Charge Voltage is selected as the default immediately after BP checker is installed.

B Elapsed Time Display

This item is used to set the elapsed time display shown in the ribbon display portion
on each channel window and in the monitor window. "Phase Local" causes local
elapsed time for each phase of the testing process to be displayed, while "Total"
causes total elapsed time from the beginning of testing to be displayed.
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5.6 Processing During Power Failures

This application does not perform power failure processing due to the large number
of files which are handled. However, as for PFX unit itself, it is designed to continue
testing even when there is a power failure. Test Executive can perform continuous
testing using the Group Continue function even after system restoration as long as the
personal computer has not been powered down by the resume function.
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CHAPTER 6
MAKING GRAPHS FROM
TEST RESULTS -

BPC Graph

This chapter will describe how to make graphs from test results, and how to display
these graphs on the screen and print them out.

Sections in Chapter 6

6.1 Starting BPC Graph
6.2 Displaying Graphs

6.3 Overlaying Graphs

6.4 Displaying Report Files
6.5 Displaying Settings

6.6 Printing

6.7 Options
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6.1 Starting BPC Graph

BPC Graph is a program that generates graphs and lists from test results files, and
displays them on the screen or prints them out. The results files are created during
testing by Test Executive. Simple graph displays are even possible under Test
Executive. However, Test Executive cannot make any reports from test results or
overlaying multiple graphs. BPC Graph should be used for data processing of this
type after testing has been completed.

BPC Graph does not communicate via GPIB with PFX units. And since it is too busy
to operate GPIB by Test Executive during testing, it is better to execute BPC Graph
after testing is completed.

To execute BPC Graph, double-click on the "BPC Graph'" icon.

gram Manager

File Options Window Help

Battery Performance Checker

Folder Editor TestEwecutve BPCGraph  BPCSpy  ReadMe

; \ Double-click here
%

BPC Screen Screen
Connection Blanker Blanker Help
Diag

eeal aas aaa aea aaa aaa
| A¥S A¥S iAZe Aze A¥O Ave
Borland C++ Borland Pascal Microsoft  Visual Basic GPIB Software
; 451 Warks 30 Development
Kit 31

Figure 6-1 Starting BPC Graph

6.2 Displaying Graphs

6-2

There are two ways to display graphs. One way is to read test results files generated
by Test Executive into a data window and then generate a graph window based on
this data. The other way is to generate a graph window directly without displaying a
data window. This can be done by selecting "How To Open Graph" from the
"Options' menu. Here, we will explain the default graph display method in which a
data window is used.
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Displaying the data window

To display the data window, it is necessary to open test result files. Select "Open
Graph" from the "File" menu.

BPC Graph

|31 Options Help
' Open Graph...
Open Report...

Open Unit Setup...
Open Worksheet...

Printer Setup...
Exit

Figure 6-2 Opening a Graph File
Then, a dialog box for selecting a file name will appear. Move to the directory

specified under Test Executive as the location to save test results files, and select the
desired file type by its associated extension.

g data.12

Discharge Voltage [*.gd'

Figure 6-3 Selecting a Graph File

There are eight types of files which can be selected for making graphs at this time.
Search for the desired file from these files. File names for charge/discharge
characteristics represent their cycle numbers. Once you have selected a file, the data
window for the file will appear.
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Charge characteristics

Charge Voltage (*.GCV)
Charge Current (*.GCC)
Charge Temperature (*.GCT)

Discharge characteristics

Discharge Voltage (*.GDV)
Discharge Current ( *.GDC)
Discharge Temperature (*.GDT)

Life characteristics

Charge Life (*.GCL)
Discharge Life (*.GDL)

BPC Graph
le Edit

<< Full Discharge >>

Unit : 1 Channel : 2

Cycle 1
Test Start : 94/2/22 20:58

Capacity H .589[Ah]
Unloaded Volt H .399([V]
Start Volt H .337[V)
Mid Cap Volt 1 1.2251V]
Nomi Cap Volt : 0.000([V]
Ave Volt 1 1.199[V]

Figure 6-4 Data Window

The data window is a window in which graph file data is displayed in a table. This
window appears immediately after a graph file is opened. This window is the starting
point for displaying graphs. The operations described to follow can be performed
from this window.

M Pasting data to spreadsheet software

You can paste data to spreadsheet software such as "Microsoft Excel" or "Lotus 1-2-
3" via the clipboard. To do this, click once on '"Point" in the upper left of the table,
and then select "Copy" from the "Edit" menu. This will cause data to be copied to the
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clipboard. Next, bring the spreadsheet software to the top on the display, and select
"Paste” from the "Edit" menu.

M Saving data in text format

Data in the data window can be saved in text format. Files saved in this format can be
read by standard text editors and word processors. To save data in text format, select

"Save As Text" from the "File" menu.

The file name used when saving in text format, is the same as that of the graph file,
but with a different extension. Naming conventions are outlined below.

Charge characteristics

Generated file name =

Voltage xxxxx.GCV
Current xxxxx.GCC
Temperature xxxxx.GCT

Discharge characteristics

Voltage xxxxx.GDV
Current xxxxx.GDC
Temperature xxxxx.GDT

Life characteristics

Charge LIFE.GCL
Discharge LIFE.GDL

| [\ni-cdvdata 12500001 1d

Uy

Uy

B data.12

Text File [=.tDVY)

Figure 6-5 Saving Data in Text Format

Creating graphs

Text format file name
xxxxx. TCV
xxxxx.TCC
xxxxx.TCT

xxxxx. TDV
xxxxx. TDC
xxxxx. TDT

LIFE.TCL
LIFE.TDL

Graphs of characteristics data are displayed in a graph window. This graph window
is generated by extracting data from the data window previously described. To
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display a graph, select ""Graph" from under "View" on the menu bar.

On the graph window, you can change axis settings, overlay graphs with other graphs
already displayed, and print graphs.

Differing graph types are displayed in the following colors.

Voltage ....cooveveveerervvennnne Green
Current......ccceeeeeveeceennee. Red
Temperature ........ccceenn.e. Blue
Charge capacity .............. Red
Discharge capacity ......... Green

Voltage [V ]

<< Full Dischargsg
1.500+

Unit : 1 Channe

1250 ™

1.000+ Cycle

i Test Start
0.750+
Capacity
0.500+4 Unloaded Volt

Start Volt
0.250 Mid Cap Volt
0.000
0

} Nomi Cap Volt

1
80 100  Ave Volt
Time [min]

Figure 6-6 The Graph Window

Setting graph axes

Clicking with the right mouse button on graph window, or selecting ""Axes" from the
"View" menu, allows you to change the setting for the vertical axis (Y axis) and
horizontal axis (X axis). In the case of life characteristics graphs, you can set the Y
axis to represent either [Ah] or [%]. Refer to the allowable input ranges shown
below, and input so that the minimum value does not exceed the maximum value.

An error message will appear if a value outside the range of data is input.
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Charge and discharge characteristics

Y axis Max. 1 to 9999
Min. 0 to 9998
X axis 0 hours, 1 minute to 999 hours, 59 minutes

Life characteristics

Y axis Max. 1 to 9999

Min. 0 to 9998
Y axis units Can represent either [Ah] or [%]
X axis Max. 1 to 99999

Min. 0 to 99998

. 1 NOTES )

- The items which can be set for graphs of charge/discharge
characteristics and life characteristics differ.

- Although data beyond the decimal point can be input for the Y axis,
an error will result if the difference between Max and Min is less than
1.

- Sometimes the maximum value on the axis of a graph will differ from
that input for Max due to some reasons of axis calculation.

- Be sure to set such that the Min value does not exceed the Max
value.

- An error message will appear if a value out of the range of data is
input.

Figure 6-7 Setting Graph Axes
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6.3 Overlaying Graphs

BPC Graph can display graphs overlaying on other graphs already displayed. Up to
three graphs can be overlaid as long as one of the following conditions is met.

Conditions for overlaying graphs

® A combination of voltage, current and temperature graphs, from the same unit,
same channel, and same cycle. However, charge graphs cannot be overlaid with
discharge graphs.

® A combination of charge life characteristics and discharge life characteristics,
from the same unit and same channel.

® A combination is of the same type of graph, from different units and different
channels. In other words, graph files whose extensions match.

To overlay graphs, select "Overlay" from the "View" menu. Once this is done, a
Graph Overlay dialog box shown below will appear. Use this dialog box to select the
graphs you wish to overlay. (Multiple selections can be made by clicking while
holding down Shift key or Ctrl key.)

C:ADATAANI-CDADATA 12\00001.GDC
C:ADATAANI-CD\DATA_12\00001.GDV

Figure 6-8 Selecting Graphs to Overlay

After selecting graphs, click on the "OK" button, and the result will appear in the
overlay graph window.
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C:\.\00001.GDV,C..\00001.GDC

1 [l
80 100
Time[min}

CDARATA 320000 GDC/Q ot GhvAR

[__ :

Figure 6-9 Overlay Graph Window

L J NOTE L 3}

It is not possible to overlay life characteristics graphs which use their
Y axis to represent a different unit. ([%] and [Ah] units cannot be
mixed.) An error message will appear if you attempt to overlay such
graphs. Be sure to combine life characteristics graphs only after
unifying every unit for the Y axis matches.

6.4 Displaying Report Files

This function generates a table of test results from the test result report files. Select
"Open Report" from the "File" menu. Then change to the directory specified under
Test Executive in which test result files are saved.
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: BPC Graph
WALl Options Help
Open Graph...

Qpen Report...

Open Unit Setup...
Open Worksheet...

Printer Setup...

Figure 6-10 Opening a Report File

The table of test results will be created from the test result report files. This file has
the extension ".REP" and two types of files described below can be displayed. Select
the report file you want to view from these two.

Charge capacity results file RSTCHG.REP
Discharge capacity results file RSTDCHG.REP

Although there are two other files with the .REP extension (RSTLIFE.REP and
WORKCOND.REP), these files are used internally by BP checker. They cannot be
viewed using BPC Graph.

E e\
[ data
workcond.rep (& nicd

A data.12

es [*.rep)

Figure 6-11 Selecting a Report File
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BPC Graph

Window Help

CADATA\NI-CDA\DATA.12\RSLTDCHG.REP
1 QOCHANNEL :

Memo : VER1.01 & bPC check Cycle
Battery Type : Ni-Ca Number Of Full
Nominal Voltage : 1.200[V]
Capacity Rate H 0.700[Ah] Hax Capacity
Hin Capacity
Start : 94/ 2/22 20:58
Last : 94/ 2/24 18:01 Result
NG Count

Cycle Charge Hode : CC
Current : O0.800[A)( 1.14[C])

Cycle Discharge Hode s CC
Current : 0.600[A) ( O.86[C]))

Figure 6-12 Report File

Saving reports in text format

BPC Graph can save the contents of displayed reports in text format. To save data in
text format, select "Save As Text" from the "File" menu. The file extension used at
this time will be changed as shown below.

Charge capacity results file RSLTCHG.REP = RSLTCHG.TXT
Discharge capacity results file RSLTDCHG.REP = RESLTCHG.TXT

\ni-cd\data.12\rsltdchg.tx

ext File [*.tDC) c: ms-dos_6

Figure 6-13 Saving Reports in Text Format
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It is also possible to copy contents of the text window to the clipboard by selecting
"Copy" (Ctrl+Ins) from under "Edit" on the menu bar. This feature can be used to
paste data to other word processors and text editors such as '"NotePad" which also run
under Windows.

6.5 Displaying Settings

6-12

BPC Graph can display unit configuration settings and worksheet contents in a text
window. When worksheet contents are displayed, information regarding the folder to
which it belongs is also displayed.

To display unit configuration settings, select "Open Unit Setup" from the "File"
menu, and change to the directory in which BP checker has been installed (C:
\BPCHKR as default). To display worksheet contents, select "Open Worksheet"
from the "File" menu, and change to the directory in which worksheets are saved by
Folder Editor.

BPC Graph

|3 Options Help :
Open Graph...
Open Report...

Open Unit Setup... |
Open Waorksheet... |

Printer Setup...
Ex

Figure 6-14 Opening a Worksheet
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Worksheet Files (*.w") |#] c: ms-dos_6

Figure 6-15 Selecting a Worksheet

Unit configuration Unit Files ( *.set)
Worksheets Worksheet Files ( *.w*)

BPC rp

CABPCA\BPCRUN\LIFEAOPTO000.WO1

-——- S3etup for PFX and Battery Check ----

Memo : Sample Worksheet
Battery Type : Ni-Cd

Nominal Voltage : 1.200[V]
Capacity Rate : 0.600[Ah]
Cycle Charge Type CC-CV Mode

Cycle Discharge Type CP Mode

Full Charge Type CC Mode

Full Discharge Type CP Mode

———- Initial Charge Setup —----

Figure 6-16 Worksheet

Just as with reports, contents of the screen can be saved in text format. To save data in
text format, select "Save As Text" from the "File" menu. The file extension used at
this time will be changed as shown below.

Unit configuration  xxxxxxxx.SET =  xxxxxxxx.TXT
Worksheets XXXXXXXX.WXxX = xxxxxxxx.Txx

It is also possible to copy contents of the text window to the clipboard by selecting
"Copy" (Ctrl+Ins) from under "Edit" on the menu bar. This feature can be used to
paste data to other word processors and text editors such as '"NotePad" which also run
under Windows.

Making Graphs from Test Results 6-13




6.6 Printing

Lines used for different graph types

All the contents displayed under BPC Graph except the data window can be printed
out.

If no printer driver has been installed under Windows, you must first open the
Control Panel and select a printer. It is also possible to change printer settings by
selecting "Printer Setup' from the "File" menu within BPC Graph.

Printings under BPC Graph are formatted for either A4 (210 x 297 mm) or letter size
(8.5 x 11 inch) portraits. Be sure to prepare for printing under these conditions. To
print, activate the window whose contents you wish to print out, and select 'Print"
from the "File" menu.

C 1 NOTE ¢ 1

Although BPC Graph itself cannot print contents of a data window, it
is possible to print this data from a spreadsheet application by
pasting this data via the clipboard to that application.

6-14

When printing an overlay graph, different graph types are represented by lines of
differing thickness and color. Under monochrome printing, this difference in line
types can only be represented by differing thickness. We recommend you use a color
printer when printing overlay graphs. The following colored lines are used when
printing in color.

Voltage .....ccceevvevereeenenennn Green
Current......ccccoevceeeieeeennn. Red
Temperature .........ccc.c.... Blue
Charge capacity .............. Red
Discharge capacity ......... Green

Lines in graphs become thicker in the following order whether printing in
monochrome or in color.

When the overlay graph combines voltage, current and temperature

Overlay Type Thin—Thick
Voltage, current, temperature Voltage—current—>temperaure
Current, temperature Current—temperaure
Voltage, temperature Voltagetemperaure
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When the overlay graph combines charge and discharge life characteristics

Overlay Type

Thin—Thick

Charge life characteristics,
discharge life characteristics

Charge life characteristics
—discharge life characteristic

When the overlay graph combines graphs of the same type (same file extension)

Lines become thicker in the order the source graph file names are sorted. (The earlier
the graph is processed, the thinner the lines used.)

6.7 Options

BPC Graph includes the following optional functions.

[How To Open Graph...]

This option is used to select whether you want a data window to be displayed first
before displaying graph windows, or whether to go directly to displaying graph

windows.

How To Open Graph Data

Figure 6-17 Selecting Graph Window Display

[Grid Lines]

This option can only be set when a graph window is active. This option is used to
set whether or not grid lines are to be included when printing the graph.
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How To Open Graph.

¥ Grid Lines

1,250—§
1.000+
0.750+
0.500+
0.250+

0.000 } t } } } }
0 20 40 60 80 100 120
Time [min]

<< Full C

Unit : 1

Cycle
Test Start

Capacity
Unloaded Volt
Start Volt
Ave Volt

Max Volt
Finish Volt

harge >>
Channel : 1

S
: 94/11/14 20:36

0.831[Ah]
1.205[V]
: 1.382([V]
1.486[V]
1.589[V)
1.549[V]

Figure 6-19 Selecting Grid Lines
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CHAPTER 7
WATCHING DATA -
BPC Spy

This chapter describes how to intercept data other than graph data created by Test
Executive from other applications.

Sections in Chapter 7

7.1 BPC Spy

7.2 Starting BPC Spy

7.3 Setting Data Acquisition Conditions
7.4 Execution Screen

7.5 Editing Data

7.6 Options
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7.1 BPC Spy

7-2

BPC Spy is an independent application program separate from the group of programs
described through Chapter 6. This application program assumes the execution of
Test Executive and is used for intercepting (obtaining) data monitored there.

Try using BPC Spy if you have any of the following dissatisfaction with graph data
created by Test Executive.

- You wish to obtain cycle charge/discharge data and data during rest.
- There are too few data points for a single test.
- You want higher resolution data for parts where the amount of change in data is

large.

*You wish to avoid missing graph data.

Note that this useful application suffers from the following disadvantages.

+ Although it depends on CPU performance, BPC Spy can only execute on about

eight channels while Test Executive is testing channels.

*BPC Spy cannot acquire data faster than the Timer Tick set by Test Executive.
-Data cannot be obtained while sending worksheet data to a unit, or while graph

data is being acquired.

-Data cannot be made into graphs using BPC Graph. (Although it can be pasted

to spreadsheet software such as Excel.)

When using BPC Spy with full understanding of these facts, select the best method
for test contents based on the understanding that graph data should not be acquired.
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7.2 Starting BPC Spy

To execute BPC Spy, double-click on the "BPC Spy" icon.

Program Manager
File Options Window Help

Battery Performance Checker

R

BF" by Read Me

@ Double-click here

GPB  BPCScreen  Scieen
Connection Blanker Blanker Help

e al eaa aes ada ada aea
Zo AZ0 490 AZe A¥o Ave
Borland C++ Borland Pascal  Microsoft Visual Basic GPIB Software
451 Works 30 Development
Kit 31

Figure 7-1 Starting BPC Spy

BPC Spy operates under the assumption that Test Executive is also running. If BPC
Spy is started when Test Executive is not running, Test Executive will also be started.

If Test Executive could not be started because PFX Config is running, quit PFX
Config and start Test Executive.
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7.3 Setting Data Acquisition Conditions

Let's try opening a channel. Open the "Channel Open" dialog box by selecting
"Open" from under "Channel" on the menu bar. This window can be used to set
conditions for data acquisition.

Channel Qptions Help

Figure 7-2 Opening a Channel

Channel Open

Figure 7-3 Channel Open Screen
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B Timing of data acquisition

The "Watch Timing" setting is used to set the timing for data acquisition. Data
acquisition timing differs depending on whether "Test Executive Synchro" or
"Asynchro" is selected.

[Test Executive Synchro]
With this setting, data is acquired based on the timing of the Timer Tick set under
Test Executive. This is the fastest timing in which the status can be monitored.

[Asynchro]
When "Asynchro" is selected, the "Watch Conditions" option will appear.
"Watch Conditions" can be used to set the timing under which data will be
acquired. When you mainly want to gather changes in data, select this option and
set acquisition conditions. This can save capacity of data.

[Watch Conditions]
Data acquisition timing can be determined based on a time interval, or amount of
change (or percent change) in voltage, current or temperature values. Data can be
acquired when any of the conditions checked here are met.
The setting range for the time interval is from 1| to 99999 seconds.
As for voltage, current and temperature, you can select whether to acquire data
based on amount of change or percent change by selecting '"Detection Method"
from under "Options" on the menu bar. The range when amount of change is set
is from 1 to 10% of the maximum value for that characteristic. The range when
percent change is set is from 1 to 999%.

B Status in which data is acquired

[Status To Spy] is used to set the statuses in which data is to be acquired. If the
status set here is monitored by Test Executive, data will be appended to the spy
window.

Status numbers in the spy window correspond to the following statuses.

Init Charge

Cycle Charge
Cycle Charge Rest
Cycle Discharge
Cycle Discharge Rest
Pre-Discharge

Full Charge

Full Charge Rest
Full Discharge

Full Discharge Rest
Post-Charge
Recharge

O 0 1 N W~

N - O
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M Data items to be acquired

Data which will be acquired are status, cycle, time as well as voltage, current or
temperature data checked under "Data Type To Spy".

[Data Type To Spy]
This setting is used to select whether or not to gather voltage, current and
temperature data. Only data for items checked here is acquired. Items which are
not selected cannot be changed later.

B Use As Default button

Clicking on this button causes all current settings to be used as default.

7.4 Execution Screen

7-6

== BPC Spy
Channel Edit Options Window Help

ME

EEHE

Unit1:Channel 1[0.2%) M

Point | Statug | Cycle [ Cumrent [A] | Voltage [V] | Temp ['C] | Time [h:mincg] | |44

10 7 1 0.909 1.583 26.0 0:00:34

1 0.909 1.584 26.0 0:00:35

12 0.909]  1.584] 26.0

13 | 1] 0903  1.585] 26.0

14 | 1] 0909 1586 26.0

15 | 1] 0903  1.58] 0 .

16 | 1] 0909 1587 26.0

17 10909 1587 26.0

18 7 1 0.909 1.588 26.0

19 7 1 0.909 1.588 26.0

20 71 0.909 1.589 26.0 K|

Figure 7-4 Spy Window

A table format window will appear after all conditions regarding data to be acquired
have been set. This window is called the "spy window", and it is connected to a given
channel. While the spy window is displayed, data will be gathered in the window and
you can see its operation once the target channel has been run using Test Executive.
During this time, The [x.x%] indicator to the right of the channel indicator on the title
bar of the spy window represents the usage of data being acquired. When this value
reaches 100%, any further data acquisition becomes impossible, so you will have to
save or cut the data until free area reaches full.

Watching Data




If you wish to change data acquisition conditions during execution, select "Spy
Settings..." from under "Channel" on the menu bar.

Figure 7-5 Screen for Changing Data Acquisition Conditions

Items displayed on this screen can be changed even during execution. These settings
are valid for the currently selected channel. "Spy Settings..." exist only for the
number of channels currently open.
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/.5 Editing Data

7-8

At the point of time the data is just acquired into the table on the spy window, no data
is saved yet. In order to effectively use this data, it is necessary to save this data in a
file or copy it to a spreadsheet application such as Excel.

Figure 7-6 Specifying Data Ranges

BPC Spy can copy data in the table displayed to the clipboard or to save it in text
format.

M Saving data in text format

To save data in text format, select ""Save As Text" from the "Channel" menu. All
contents of the table will be saved.

B Copying to the clipboard

Selected data can be copied to the clipboard by selecting "Copy" from under "Edit"
on the menu bar. However, there is a restriction on the range of data which can be
copied to the clipboard at once. If you wish to handle a large amount of data at once,
create a text file and use that file.

B Deleting data

Selected rows of data can be deleted by selecting ""Delete Rows" from under "Edit"
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on the menu bar. Note however that it can take a very long time when deleting large
amounts of data at once. If you have saved the table data and it is no longer required,
you can newly open a channel under the same settings, and just close the existing
windows containing unnecessary data instead of deleting.

7.6 Options

= Detection Method

;“‘_Qelection Method

0K

i C Percentage
i

Figure 7-7 Setting Detection Method

Selecting '"Detection Method" from under "Options'" on the menu bar allows you to
set the data acquisition timing as an absolute value in the amount of change in the
voltage, current or temperature characteristic or as a percent change in the same
characteristics. The setting made here will affect the data acquisition conditions for
the next channel which is opened.
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There are four appendices. Appendix 1 lists the error messages which appear on the
screen while operating BP checker. Appendix 2 gives samples of output produced by
BP checker. Appendix 3 describes DDE server functions possessed by BP checker.
Appendix 4 lists BP checker specifications.

APPENDIX 1
APPENDIX 2
APPENDIX 3

APPENDIX 4

ERROR MESSAGES

OUTPUT SAMPLES

COMMUNICATING WITH EXTERNAL PROGRAMS
(ADVANCED FUNCTION)

APPLICATION SPECIFICATIONS

Appendices A-1




APPENDIX 1 ERROR MESSAGES

Overall BP Checker System-Related Error Messages

Error No. —_] = GPIB Transfer

Message

An error number like that shown in the figure below is assigned to each error
message. If you want to a detailed understanding of an error message, use the error
number appearing on the screen to search for the description of that error in the list
below.

\

ERR-230
@ GPIB write error in Unit 1 - Address 1
Check the GPIB addresses and cables

Figure A1-1 Typical Error Message

A-2
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BERR-9001
Insufficient memory. Check memory capacity or quit needless applications.

There is not enough computer memory. Try increasing available memory by
terminating all unnecessary applications.

BERR-9002
File read error. Check the hard disk drive.

There was an error reading a file. The hard disk drive may be broken.

BERR-9003
File write error. Check free disk space and the hard disk drive.

This error often occurs when the hard disk becomes full while creating data during
testing. If this error occurs while Test Executive is conducting tests, all channels will
be put in HOLD status. If this happens, try to free up disk space by deleting
unnecessary data files using the File Manager. Then select "Run/Continue' from the
"Group' menu to restart all channels.




GPIB-Related Error Messages

BMERR-9008

Value must be between X and Y. Click the OK button and correct the
highlighted item.

A value out of range was input. Please input a value between X and Y. Click on the
"OK" button and correct the highlighted item.

BMERR-220

Cannot open GPIB device. Please check GPIB adapter and driver
configuration.

This error message appears when the device driver set under the system
configuration differs from the actual GPIB card in the system. Try resending data
after setting the correct driver.

BERR-223
Different model access or invalid ROM version.

The system is connected to a model other than the PFX40W-08. Please check the
model name.

BERR-230

GPIB write error; Unit x; Address x. Please check GPIB addresses and
cables.

There was a data write error during GPIB communications. This message usually
appears when first executing a test.

BERR-231

GPIB read error; Unit x; Address x. Please check GPIB addresses and
cables.

There was a data read error during GPIB communications. This message usually
appears when first executing a test. ’

BERR-301
Cannot change the PFX operation mode to SETUP mode.

This warning message appears when there is a currently executing channel
(including HOLD and END status) somewhere among the units displayed.

Appendices A-3




PFX Config-Related Error Messages

Folder Editor-Related Error Messages

ERR-2001
PFX Config cannot be run while BPC Test Executive is running.

PFX Config cannot run because Test Executive is running. Please exit Test
Executive.

BERR-2002
Max Cycle must be between 1 and 99999.

The max cycle setting is out of range. Please set it to between 1 and 99999.

IERR-2003

Interval must be between 1 and 999.

The interval setting is out of range. Please set it to between 1 and 999.

BERR-2004

Judgment margin must be between 1 and 100.

The judgment margin setting is out of range. Please set it to between 1 and 100.

BERR-2005

Judgment count must be between 1 and 9.

The judgment count setting is out of range. Please set it to between | and 9.

A-4
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MERR-3001

Value must be between 0.001 and xxxx. Click the OK button and correct the
highlighted item.

A value out of range was input. Please input a value between 0.001 and xxxx. Click
on the "OK" button and correct the highlighted item.

BERR-3003
Too many worksheet is being inserted.

The number of worksheets in the folder exceeds 99.




L

Test Executive-Related Error Messages

BERR-4001
BPC Test Executive cannot be run while the PFX Config is running.

Test Executive cannot be run because PFX Config is running. Please exit PFX
Config.

BERR-4002

Failed to create directory directory-name.

The subdirectory could not be created. Please check that an appropriate directory
name was specified.

BMERR-4003
Failed to access directory directory-name.

The subdirectory could not be accessed. Please check that an appropriate directory
name was specified.

BMERR-4004
Graph interval must be between 1 and 1000.

The graph interval setting is out of range. Please set it to between 1 and 1000.

BERR-4005

Channel range is different from the PFX configuration. Do you wish to
continue?

The PFX range information listed in the header of the folder is different from the
range setting of the actual PFX unit. While testing can be forced, there is some
concern that worksheets may not be set properly.

BMERR-4006

Failed to run in Unit x - Channel x.

There was an error in executing a test on the channel given. Please check if worksheet
contents are appropriate.
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BPC Graph-Related Error Messages

BMERR-4007

GPIB communication problem has been generated.

This error is generated when there is some problem in GPIB communications. This is
possibly caused by a GPIB cable coming loose, or an unexpected loss of power. If
this error occurs, Test Executive will work to place all channels in HOLD status. (Of
course, communications are not possible with PFX units whose lines are affected.) In
this situation, return affected lines to operable condition, and select "Restart test
loop" from the "Test" menu to restart all channels.

BERR-4008
File system problem has been generated

A problem has been found in the file system. The hard disk may be broken or there is
insufficient free space.

BMERR-4009
Alarm detected in Unitx - Channel x.

This error occurs when an alarm is generated by the PFX40W-08 during test
execution. If this happens, Test Executive puts the channel on which the alarm was
detected in HOLD status. Testing for other channels will continue normally. Once
the cause of the alarm on the channel in HOLD status is cleared, select "Continue"
from the "Test" menu, and restart the channel in HOLD status.

BERR-4010
Invalid folder/worksheet file

An attempt was made to read an invalid folder/worksheet file.

MERR-4011

Directory you specify should be a full path name that begins with a valid drive
letter.

The directory name must be a full path name beginning with a valid drive letter.

A-6
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MERR-5000

Insufficient memory

There is not enough memory. Try increasing available memory by terminating all
unnecessary applications.




BMERR-5001
No data is found in the graph file.

There is no data in the selected graph file.

MERR-5002
No data is found in the report file.

There is no data in the selected report file.

BMERR-5003
File data error

There is a data error in the selected file. This may be test data used in the past.

HMERR-5004
Data is broken or not found.

The selected file or required file is destroyed or cannot be found.

BMERR-5005
Cannot open file.

An uneditable file name was input. Please input a proper file name.

BERR-5006
There's no valid printer.

No printer driver has been set. Select a printer driver on the Control Panel.

BERR-5007
Axis value out of range

Data out of range was input when changing axes. Valid data ranges are as follows.

Charge and discharge characteristics

Y axis Maximum is 1 to 9999
Minimum is 0 to 9998
X axis 0 hours, 1 minute to 999 hours, 59 minutes
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Charge and discharge characteristics

Y axis Maximum is 1 to 9999

Minimum is O to 9998

Y axis units can represent either [Ah] or [%]
X axis Maximum is 1 to 99999

Minimum is 0 to 99998

An error results when Maximum is less than Minimum or when the difference is less
than 1.

BERR-5008
Cannot overlay

A combination which cannot be overlaid has been selected.

BMERR-5009
Life graphs (Ah and %) cannot be combined.

An attempt has been made to overlay life characteristics graphs whose Y axes
represent different units. Change the Y axis unit of one of the graphs to match the
other and try again.

WERR-5010
Disk Full

There is no free space on the disk. Clean out the hard disk by deleting unnecessary
files.

BPC Spy-Related Error Messages

A-8
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BERR-6001
BPC-Test-Executive cannot be run.

Test Executive cannot be run. Quit PFX Config, and try executing BPC Spy again.

BERR-6002
Insufficient memory

There is not enough memory. Try increasing available memory by terminating all
unnecessary applications.



T e

BERR-6003

Select any one of Watch Condition

None of the items listed under Watch Condition have been selected.

BERR-6004
Value must be between x and x.

An invalid range has been set. The valid range is 1 to 999% when setting percent
change, and 1 to 10% of maximum value for that item when setting amount of
change.

BMERR-6005
The amount of spy data on the table is reaching full size.

The amount of data has reached the limit securable BPC Spy. Delete some rows after
saving current data.

MERR-6006
Disk Full

There is no free space on the disk. Clean out the hard disk by deleting unnecessary
files.

BERR-6007
The data being copied into the clipboard is too large.

The amount of data specified for copying onto the clipboard exceeds the amount that
can be copied at one time. Copy the data in smaller pieces. If copying in smaller
pieces is too troublesome, save it as a text file first.

BERR-6008
No Timer available

The timer cannot be used any further. Close any other applications using the timer
and try again.

BERR-6010
Test Executive is too busy to respond DDE-conversation.

There was no DDE transmission from Test Executive. It is conceivable that Test
Executive is currently acquiring graph data. Select "Retry" in the message box and
try again. Execution on the selected channel can be terminated by selecting ""Cancel".
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Other BPC Graph and BPC Spy Error Messages

BERR-9999
unexpected error ! (Error message number)

An unexpected error has occurred. Check the following things and contact Kikusui's
customer service department or your Kikusui agent.

Items to check:
1. Error message number
2. Name of the application generating the error message (BPC Graph or BPC
Spy)
3. Status in which the error message was generated
Contact:
Kikusui Electronics Corp. Customer Service Department
TEL 045-593-0202 JAPAN
FAX 045-593-0207 JAPAN

APPENDIX 2 OUTPUT SAMPLES
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Appendix 2 lists 12 samples of output which can be generated using BPC Graph.

Sample I  Charge Graph (Voltage: 1 Source) A-11

Sample 2 Charge Graph Overlay (Voltage, Current, Temperature: 3 Sources) A-12
Sample 3  Discharge Graph (Voltage: 1 Source) A-13

Sample 4  Discharge Graph Overlay (Voltage: 3 Sources) A-14

Sample 5  Charge Life Characteristics Graph Overlay (2 Sources [Ah])
Sequence Mode A-15

Sample 6  Charge/Discharge Life Characteristics Graph Overlay (2 Sources [%])
Life Cycle Mode A-16

Sample 7  Charge Life Characteristics Report
Life Cycle Mode A-17

Sample 8 Discharge Life Characteristics Report
Sequence Mode A-18

Sample 9  Charge Report
Sequence Mode A-19

Sample 10 Discharge Report
Life Cycle Mode A-20

Sample 11 Unit Configuration File A-21
Sample 12 Worksheet File A-22, A-23



Sample 1

Charge Graph (Voltage: 1 Source)

UNIT 1
CHANNEL : 2

Voltage[ V ]

1.7507—

1.500

Kikusui/BP-Checker
A:\NI-CD\DATA.12\00002.GCV

<<< Voltage Transition >>>

Full Charge

]
'
'
0
.
1
i
.
1
'
1
'

1.000¢
0.750+4 !
0.500+ ‘
0.250 j
0.000 : - + — '. :
0 20 40 60 1 80 100 120
1:16:36
Time [min])
Memo VER1.01 & bPC check Cycle 2/800
Battery Type Ni-Cd Number Of Full 2/800
Nominal Voltage : 1.200(V]) Test Start 94/ 2/22 22:12
Capacity Rate : 0.700(Ah) Finished By -dv
Charge On CC Mode Unloaded Voltage 1.199(V]
Current : 0.700[A) ( 1.00(C]) Start Voltage 1.294(V)
Average Voltage 1.436(V]
Peak Voltage 1.527(V]
Finish Voltage 1.507{V]
Judgment Margin : 60(%]( 0.420[Ah])
Capacity 0.768[Ah] Max Voltage 1.527[V]
Capacity / Nom 109.7 (%] Min Voltage 1.238[V]
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Sample 2

50.00¢1
45.00¢1
40.00+
35.004
30.00¢1

25.004

0.00I

A-12

Charge Graph Overlay (Voltage,Current,
Temperature: 3 Sources)

UNIT :1 Kikusui/BP-Checker
CHANNEL : 1
<<< Volt, Curr, Temp Transition >>>
Full Charge
[A] {v] Volt Curr Temp
2.0004 1.750¢4 ?
1.5004
1.500¢4 i
1.250¢4 !
1.000¢ E
1.0004
0.750¢ é
0.500+4 %
0.500+
0.250¢ j
S
0.000L 0.000 } } } ; .
0 20 40 60 80
1:04:42
Time [min]
Memo : Charge & Discharge Cycle 2
Battery Type : Ni-Cd
Nominal Voltage : 1.200(V] Test Start 94/11/14 16:00
Capacity Rate 0.700[Ah] Finished By -dv
Charge On CC Mode Unloaded Voltage 1.216(V}
Current 0.910([A) ( 1.30([C}) Start Voltage : 1.413[V)
Average Voltage H 1.492([V]
Peak Voltage : 1.586([V]
Finish Voltage 1.546 (V]
Judgment Margin : 100[%]( 0.700[Ah])
Capacity 0.863[Ah] Max Voltage 1.586([V]
Capacity / Nom 123.2([%) Min Voltage 1.022(V]
Max Current 0.910[A]
Min Current 0.200(A]
Max Temperature 37.2(°C]
Min Temperature 27.2[°C}
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Sample 3

Discharge Graph (Voltage: 1 Source)

UNIT HE |
CHANNEL : 2

Kikusui/BP-Checker
A:\NI-CD\DATA.12\00001.GDV

<<< Voltage Transition >>>

Full Discharge

Voltage[ V ]
12 500w :
1.250 \ ke
1.000 :
0.750
0.500 -
0.250 ;
0.000 :
0 10 20 30 40 ; 50 60
0:44:10
Time[min]
Memo : VER1.01 & bPC check Cycle 1/800
Battery Type Ni-Cd Number Of Full 1/800
Nominal Voltage : 1.200(V] Test Start 94/ 2/22 20:58
Capacity Rate 0.700([Ah) Finished By OK
Discharge On CC Mode Unloaded Voltage 1.399[V]
Current 0.800[A) ( 1.14[C)) Start Voltage 1.337(V]
Depth : 142.9(%]) Middle Capacity Volt 1.225[V]
Cutoff Voltage: 0.500[V] Nominal Capacity Volt 0.000(V]
Average Voltage 1.199[V]
Judgment Margin : 60({%]{ 0.420[Ah})
Capacity 0.589[Ah) Max Voltage 1.375(V]
Capacity / Nom 84.2[%] Min Voltage 0.547 (V)
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Sample 4 Discharge Graph Overlay (Voltage: 3 Sources)

Kikusuil/BP-Checker

<<< Voltage Transition >>>
Full Discharge
{ v No.1 No.2 No.3

6.000¢

5.000

4.0001

3.000+4+

2.000¢

1.000¢+

0.000 } : }

Time [min]

Test Contents

No. Unit Channel Memo Battery Type Discharge
1 1 7 seq Nol Ni-MH 0.600[A]
2 1 7 seq No3 Ni-MH 1.000([A]
3 1 7 seq Nod Ni-MH 0.500([A]

No. Cycle Capacity Unloaded Start Middle NomiCap Max Min Average Judgment
Voltage Voltage Voltage Voltage Voltage Voltage Voltage

1 1 0.351 5.831 5.213 4.481 0.000 5.544 4.001 4.495 Min Volt

2 6 0.212 5.866 4.754 4.217 0.000 5.350 4£.002 4.277 Min Volt

3 7 0.360 5.887 5.226 4.527 0.000 5.564 4.002 4.531 Min Volt
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Sample 5

Charge Life Characteristics Graph Overlay (2 Sources [Ah])

Sequence Mode

Kikusui/BP-Checker

<<< Charge Life Characteristic >>>
Sequence Mode

[ mAh ] No.l-—— No.C
1.0004
0.7504
0.500¢
0.2504
0.000 J % — — ;
1 5 10 15 20 25 30

Test Contents

1 1 1 normal test (1C) Ni-~Cd
2 1 3 normal test (1C) Ni-Cd

Test Results

No Start Time Last Time Cycle MaxCap MinCap
1 94/11/29 15:51 94/12/ 1 17:16 15 0.911 0.000
2 94/11/29 15:51 94/12/ 1 15:24 16 0.796 0.000
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Sample 6

Charge/Discharge Life Characteristics Graph Overlay
(2 Sources [%]) Life Cycle Mode

UNIT : 1 Kikusui/BP-Checker
CHANNEL : 2

<<< Charge & Discharge Life Characteristic >>>
Life Cycle Mode

[ %] Charge Discharge
120.00¢
100. 001
——
80.00¢+
60.001+
40.00+
20.00+
0.00 ] % % + t
1 10 20 30 40 50
Cycle[count]
Memo : VER1.01 & bPC check Cycle : 16/800
Battery Type : Ni-Cd Number Of Full : 16/800
Nominal Voltage : 1.200[V]
Capacity Rate : 0.700[Ah] Max Capacity : 0.769([Ah] 0.592[Ah]
Min Capacity : 0.754[Ah] 0.582(Ah]
Start : 94/ 2/22 15:18
Last : 94/ 2/24 16:15 Result :
NG Count : 0/9
Cycle Charge Mode : CC
Current : 0.800(A] ( 1.14([C})
Cycle Discharge Mode ¢ CC
Current : 0.600([A} ( 0.86[C))
Discharge Depth : 114.3[%]
Cutoff Voltage : 0.500({V]
Full Charge Mode He
Current : 0.700[A] ( 1.00([CI)
Full Discharge Mode : CC
Current :  0.800(A]( 1.14(C])
Discharge Depth : 142.9[%)
Cutoff Voltage : 0.500([V]
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Sample 7

Charge Life Characteristics Report
Life Cycle Mode

UNIT : 1
CHANNEL : 2

Kikusui/BP-Checker
Date: 12-05-1994
Time: 16:57:28

C:\DATA\DATA.12\RSLTCHG.REP

== =m==

Charge Result

Memo : Cycle 30/30
Battery Type : Li Number Of Full 30/30
Nominal Voltage : 14.400[V
Capacity Rate 1.000(AN) Max Capacity 1.067 [Ah]
Min Capacity 0.878[Ah]
Start 94/ 6/17 18:47
Last 94/ 6/21 7:21 Result oK
NG Count 0/9
Cycle Charge Mode : CC
Current 0.001(A} { 0.00(C])
Cycle Discharge Mode cC
Current 0.001[A) ( 0.00(C))
Discharge Depth 0.0([%]
Cutoff Voltage 0.001([V]
Full Charge Mode CC-CV
Current 1.000([A]
Voltage 16.800([V]
Full Discharge Mode . CC
Current : 1.000([A] ( 1.00([C])
Discharge Depth : 150.0(%]
Cutoff Voltage 10.800[V]
Date: 12-05-1994
Time: 16:57:28
Charge Result
Cycle Date Time Capacity Unloaded Start Average Max Finish Finished
Voltage Voltage Voltage Volitage Voltage By
[Y/ M/ D] [h:min] fAh] v} (v} tvi ]
1 94/ 6/17 18:47 0.878 14.082 15.173 16.584 16.818 16.808 Time
2 94/ 6/17 21:35 1.067 12.161 13.388 16.264 16.823 16.809 Time
3 94/ 6/18 0:38 1.056 12.185 13.418 16.271 16.809 16.809% Time
4 94/ /18 3:39 1.050 12.201 13.439 16.276 16.809 16.809 Time
5 94/ 6/18 6:40 1.047 12.216 13.453 16.279 16.826 16.804 Time
6 94/ 6/18 9:40 1.041 12.219 13.454 16.280 16.809 16.809 Time
7 94/ 6/18 12:39 1.030 12.264 13.515% 16.292 16.823 16.809 Time
8 94/ 6/18 15:37 1.023 12.294 13.556 16.301 16.809 16.809 Time
9 94/ ©/18 18:35 1.034 12.274 13.523 16.293 16.824 16.784 Time
10 94/ 6/18 21:33 1.033 12.273 13.511 16.291 16.814 16.808 Time
11 94/ 6/19 0:32 1.025 12.304 13.553 16.29¢9 16.810 16.809 Time
12 94/ 6/19 3:30 1.019 12.330 13.582 16.305 16.809 16.808 Time
13 94/ 6/19 6:26 1.014 12.34¢9 13.605 16.310 16.822 16.809 Time
14 94/ 6/19 9:23 1.009 12.372 13.628 16.315 16.829 16.808 Time
15 94/ 6/19 12:19 1.009 12.383 13.634 16.316 16.835 16.825 Time
16 94/ 6/19 15:14 1.003 6.699 13.661 16.320 16.82% 16.809 Time
17 94/ 6/19 18:09 0.999 6.721 13.684 16.324 16.832 16.808 Time
18 94/ 6/19 21:04 0.991 6.747 13.715 16.331 16.809 16.809 Time
19 94/ 6/19 23:58 0.984 6.773 13.750 16.338 16.809 16.808 Time
20 94/ 6/20  2:51 0.978 6.797 13.780 16.345 16.809 16.809 Time
21 94/ 6/20 5:43 0.972 6.821 13.807 16.350 16.826 16.80¢ Time
22 94/ 6/20 8:34 0.976 6.830 13.795 16.346 16.811 16.808 Time
23 94/ 6/20 11:27 0.972 6.849 13.821 16.352 16.813 16.808 Time
24 94/ 6/20 14:18 6.970 6.867 13.832 16.354 16.809 16.808 Time
25 94/ 6/20 17:10 0.966 6.885 13.849 16.357 16.826 16.809 Time
26 94/ 6/20 20:01 0.966 6.905 13.867 16.360 16.827 16.800 Time
27 94/ 6/20 22:52 0.960 6.918 13.871 16.361 16.820 16.808 Time
28 94/ 6/21 1:43 0.950 6.945 13.917 16.371 16.809 16.808 Time
29 94/ 6/21 4:32 0.944 6.968 13.947 16.377 16.809 16.808 Time
30 94/ 6/21 7:21 0.944 6.988 13.965 16.380 16.828 16.812 Time
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Sample 8
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Discharge Life Characteristics Report
Sequence Mode

UNIT 1
CHANNEL : 3

Kikusui/BP-Checke

Date:
Time:

12-06-199
11:02:58

C:\BPCDATA\SEQDATA\DATA. 13\RSLTDCHG. RE

Discharge Result

Battery Type : Ni-Cd
Nominal Voltage : 1.200{V
Capacity Rate 0.600(Ah]
Cycle Memo Charge Discharge
1 charge skip test 0.001(A] 0.700(A]
2 normal test (1C) 0.910([A] 0.700[A)
3 normal test (1C) 0.910[A] 0.700 (R}
4 normal test (1C) 0.910(A} 0.700[A)
5 normal test (1C} 0.910([A] 0.700(A)
6 normal test (1C) 0.910(A) 0.700([A}
7 normal test (0.5C) 0.455[A] 0.350(A)
8 normal test (0.5C) 0.455([A] 0.350(A)
9 normal test {0.5C) 0.455(A] 0.350([A]
10 normal test (0.5C) 0.455[A] 0.350[A]
11 normal test (0.5C) 0.455(A) 0.350[A]
12 normal test (1C) 0.910[A) 0.700[A]
13 normal test (1C) 0.910[A] 0.700[A)
14 normal test (1C) 0.910[A) 0.700{A)
15 normal test (1C) 0.910(A] 0.700(A]
16 normal test (1C) 0.910([A) 0.700([A)

Date: 12-06-1994
Time: 11:02:58
Discharge Result
Cycle Date Time Capacity Unloaded Start Middle NomiCap Average Judgment
Veoltage Voltage Voltage Voltage Voltage
[Y/ M/ D) [h:imin) {Ah) (v} v] (v] [vi [v)
1 94/11/29% 15:52 0.613 1.388 1.193 1.102 0.963 1.091 oK
2 94/11/29 17:53 0.628 1.401 1.217 1.103 0.9%6 1.092 OK
3 94/11/29 19:57 0.627 1.401 1.219 1.105 0.994 1.093 OK
4 94/11/29 21:59 0.626 1.405 1.224 1.107 0.992 1.095 OK
5 94/11/30 8:49 0.605 1.377 1.189 1.106 0.775 1.090 oK
6 94/11/30 10:51 0.629 1.402 1.222 1.108 1.000 1.097 OK
7 94/11/30 13:50 0.644 1.403 1.308 1.191 1.101 1.180 OK
8 94/11/30 17:44 0.643 1.407 1.311 1.192 1.102 1.181 OK
9 94/11/30 21:36 0.641 1.409 1.314 1.193 1.101 1.182 OK
10 94/12/ 1 1:26 0.639 1.413 1.317 1.194 1.101 1.184 OK
11 94/12/ 1 5:13 0.638 1.416 1.319 1.195 1.101 1.185 oK
12 94/12/ 1 8:12 0.627 1.409 1.235 1.115 1.005 1.104 OK
13 94/12/ 1 10:14 0.628 1.407 1.233 1.114 1.005 1.103 oK
14 94/12/ 1 12:17 0.629 1.403 1.228 1.113 1.004 1.101 OK
15 94/12/ 1 14:20 0.629 1.402 1.227 1.111 1.004 1.100 oK
16 94/12/ 1 16:22 0.629 1.403 1.228 1.112 1.004 1.101 OK




Sample 9 Charge Report
Sequence Mode

Kikusui/BP-Checker
_1 /2 UNIT 01 Date: 12-06-1994
CHANNEL : 3 Time: 11:04:40

C:\BPCDATA\SEQDATA\DATA. 13\RSLTCHG.REP

Charge Result

Battery Type : Ni-Cd
Nominal Voltage : 1.200([V
Capacity Rate : 0.600[Ah)
Cycle Memo Charge Discharge
1 charge skip test G.001(A} 0.700{A)
2 normal test (1C) 0.910(A) 0.700(A]
3 normal test (1C) 0.910[A) 0.700[A)
4 normal test (1C) 0.910(A] 0.700[A}
5 normal test (1C) 0.910([A] 0.700[A]
6 normal test (1C) 0.910[A] 0.700[A]
7 normal test (0.5C) 0.455([A) 0.350([A)
8 normal test (0.5C) 0.455[A] 0.350(A)
9 normal test (0.5C) 0.455(A) 0.350(A)
10 normal test {0.5C) 0.455{A) 0.350[A)
11 normal test {0.5C) 0.455({A) 0.350([A]
12 normal test (1C) 0.910[A] 0.700[A)
13 normal test (1C) 0.910(A] 0.700(A]
14 normal test (1C) 0.9210([A] 0.700[A]
15 normal test (1C) 0.910(A) 0.700(A]
16 normal test (1C) 0.910[A) 0.700([A]
2/2 Date: 12-06-1994
_ Time: 11:04:41
Charge Result
Cycle Date Time Capacity Unloaded Start Average Max Finish Finished
Voltage Voltage Voltage Voltage Voltage By
(Y/ M/ D} ([h:min] [Ah} v] V) vi v] Vi
1 94/11/29 15:51 0.000 1.390 0.000 0.810 1.389 1.041 Time
2 94/11/29 16:54 0.745 1.212 1.520 1.637 1.741 1.711 -dv
3 94/11/29 18:57 0.748 1.212 1.519 1.636 1.738 1.708 -dv
4 94/11/2% 21:00 0.739 1.211 1.518 1.636 1.742 1.713 -dv
S 94/11/29 23:03 0.740 1.212 1.517 1.635 1.742 1.713 -dv
6 94/11/30 9:51 0.750 1.214 1.507 1.626 1.732 1.704 ~dVv
7 94/11/30 11:55 0.797 1.212 1.380 1.509 1.589 1.559 ~-dv
8 94/11/30 15:50 0.786 1.199 1.383 1.510 1.595 1.565 -dv
9 94/11/30 19:44 0.770 1.201 1.384 1.511 1.601 1.571 -dV
10 94/11/30 23:36 0.755 1.202 1.385 1.513 1.608 1.578 -dv
11 94/12/7 1 3:25 0.743 1.203 1.386 1.514 1.613 1.583 -dv
12 94/12/ 1 7:13 0.741 1.203 1.514 1.631 1.743 1.713 -dv
13 94712/ 1 9:16 0.729 1.214 1.508 1.624 1.736 1.706 -dv
14 94/12/ 1 11:18 0.740 1.212 1.506 1.62 1.72 1.695 ~-dv
15 94/12/ 1 13:21 0.737 1.211 1.507 1.621 1.72 1.693 -dv
16 94/12/ 1 15:24 0.736 1.210 1.508 1.622 1.72 1.694 -dv
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Discharge Report
Life Cycle Mode

UNIT c 1
CHANNEL : 2

Kikusui/BP-Checker
Date: 12-05-1994
Time: 16:57:45

C:\DATA\DATA.12\RSLTDCHG. REP

Discharge Result

Memo : Cycle 30/30
Battery Type : Li Number Of Full 30/30
Nominal Voltage : 14.400(V
Capacity Rate 1.000({Ah] Max Capacity 1.051(Ah)
Min Capacity 0.934'Ah]
Start 94/ 6/17 20:23
Last 94/ 6/21 9:03 Result OK
NG Count /9
Cycle Charge Meode : CC
Current 0.0012(A){ 0.00[C])
Cycle Discharge Mode cC
Current 0.001(A] ( 0.00(C])
Discharge Depth : 0.0(%]
Cutoff Voltage 0.001([V]
Full Charge Mode : CC-CcV
Current 1.000(A]
Voltage 16.800(V]
Full Discharge Mode : CC
Current 1.000([A])( 1.00(C])
Discharge Depth : 150.0(%]
Cutoff Voltage 10.800(V]
Date: 12-05-1994
Time: 16:57:46
Discharge Result
Cycle Date Time Capacity Unloaded Start Middle NomiCap Average Judgment
Voltage Voltage Voltage Voltage Veltage
[Y/ M/ D] (h:min) [Ah] v] v] (v] v] [v]
1 94/ 6/17 20:23 1.044 16.662 15.807 14.401 11.332 14.013 OK
2 94/ 6/17 23:25 1.051 16.690 15.842 14.422 11.409 14.036 oK
3 94/ 6/18 2:26 1.043 16.685 15.831 14.413 11.350 14.036 OK
4 94/ 6/18 5:27 1.039 16.685 15.828 14.409 11.317 14.033 OK
5 94/ 6/18 8:28 1.038 16.685 15.832 14.419 11.318 14.043 oK
6 94/ 6/18 11:28 1.026 16.679 15.809 14.392 11.203 14.027 OK
7 94/ 6/18 14:26 1.017 16.674 15.796 14.386 11.120 14.023 OK
8 94/ 6/18 17:23 1.019 16.668 15.789 14.377 11.123 14.014 oK
9 94/ 6/18 20:22 1.026 16.682 15.822 14.409 11.231 14.048 OK
10 94/ 6/18 23:21 1.021 16.683 15.817 14.404 11.178 14.045 OK
11 94/ 6/19  2:19 1.013 16.678 15.805 14.394 11.091 14.044 0K
12 94/ 6/19 5:16 1.008 16.676 15.799 14.391 11.016 14.043 oK
13 94/ 6/19 8:12 1.003 16.675 15.794 14.385 10.923 14.044 oK
14 94/ 6/19 11:08 1.001 16.673 15.792 14.386 10.841 14.043 oK
15 94/ 6/19 14:04 0.998 16.677 15.799 14.393 0.000 14.057 oK
16 94/ 6/19 17:00 0.993 16.674 15.793 14.386 0.000 14.057 OK
17 ¢4/ 6/19 19:55 0.988 16.673 15.791 14.387 0.000 14.060 OK
18 94/ 6/19 22:49 0.979 16.671 15.779 14.375 0.000 14.059 OK
19 94/ 6/20 1:42 0.973 16.668 15.771 14.368 0.000 14.057 OK
20 94/ 6/20 4:35 0.967 16.665 15.763 14.363 0.000 14.054 0K
21 94/ 6/20 7:26 0.966 16.663 15.765 14.369 0.000 14.064 CK
22 94/ 6/20 10:19 0.966 16.670 15.773 14.372 0.000 14.072 oK
23 94/ 6/20 13:11 0.963 16.670 15.776 14.378 0.000 14.080 OK
24 94/ 6/20 16:02 0.961 16.673 15.780 14.382 0.000 14.083 oK
25 94/ 6/20 18:54 0.956 16.671 15.774 14.377 0.000 14.087 OK
26 94/ 6/20 21:45 0.958 16.677 15.794 14.403 0.000 14.110 OK
27 94/ &/21 C:36 0.948 16.672 15.770 14.377 0.000 14.092 oK
28 94/ 6/21 3:26 0.939 16.667 15.757 14.362 0.000 14.087 OK
29 94/ 6/21 6:15 0.934 16.665 15.750C 14.357 0.000 14.082 OK
30 94/ 6/21 9:03 0.938 16.672 15.778 14.387 0.000 14.114 oK




.

Sample 11 Unit Configuration File

Date: 12-05-1994
Time: 16:46:24

C:\BPCHKR\UNIT1.SET

Unit Setup
---- Test Condition --=--
Range : 8channels/20V-2A
Measurement : Yes
Synchronization : No

---- Cycle Format ----

Max Cycle :1000
Interval : 1
Judgment Margin : 100
Judgment Count : 9
Final Recharge : No
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Worksheet File

Date: 12-05-19934
Time: 16:52:30

C:\EPCHKR\LIFE\TEST1.W01

WorkSheet
—---- Setup for PFX and Battery Check ----
Memo :
Battery Type : Ni-cd
Nominal Voltage 1.200(V)
Capacity Rate H 0.700[Ah)
Cycle Charge Type : CC Mode
Cycle Discharge Type : CC Mode
Full Charge Type : CC Mode
Full Discharge Type : CC Mode
---~ Initial Charge Setup ~---
Step No Charge Current " Charge Time
[A] (h:min]
1 0.000 0:00
2 0.000 0:00
3 0.000 0:00
4 0.000 0:00
5 0.000 0:00
6 0.000 Q0:0Q0
7 0.000 0:00
8 0.000 0:00
9 0.000 0:00
10 0.000 0:00
11 0.000 0:00
12 0.000 0:00
13 0.000 0:00
14 0.000 Q0:00
15 0.000 a:00
16 0.000 0:00
17 0.000 0:00
18 0.000 0:00
19 0.000 0:00
20 0.000 0:00
21 0.000 0:00
22 0.000 0:00
23 0.000 0:00
24 0.000 0:00
25 0.000 0:00
26 0.000 0:00
27 0.000 0:00Q
28 0.000 0:00
29 0.000 0:00
30 0.000 0:00




Date: 12-05-1994
Time: 16:52:30
WorkSheet
---- Cycle Charge Setup ----
Mode : CC
Charge Current : 0.500(A]
Charge Time H 0:30 [h:min]}
Aux Charge Current H 0.001(A]
Aux Charge Time H 0:01 ([h:min]
Rest Time : 0:05 [h:min]
-dVv ¢ 30[mV]
dT/dt : 1.2[°C/min]
Max Voltage : 1.800(V]
Max Temperature : 60[°C}
—--=- Cycle Discharge Setup ----
Mode : CC
Dscharge Current : 0.500[A]
Dscharge Time : 0:30 [h:min]
Rest Time : 0:05 [h:min)
Min Voltage : 0.600([V]
—--=-= Full Charge Setup ----
Mode : CC
Charge Current : 0.910[A)
Charge Time 1:10 [h:min]
Aux Charge Current 0.200([A]
Aux Charge Time 0:20 (h:min]
Rest Time : 0:10 (h:min]
-dv : 30[mV)
dT/dt : 1.2{°C/min]
Max Veltage : 1.800(V)
Max Temperature : 607°C)
Pre-Discharge Current B 0.001(A)
Pre-Discharge Time : 0:00 [h:min)
Pre-Discharge Min Voltage : 0.001[V]
—--=-~ Full Discharge Setup ----
Mode : CC
Discharge Current B 0.700[A]
Discharge Time 1:30 (h:min]
Rest Time 0:10 [h:min]
Min Voltage 0.600([V]
Post-Charge Current 0.001(A)
Post~Charge Time 0:00 [h:min]
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APPENDIX 3 COMMUNICATING WITH
EXTERNAL PROGRAMS
(ADVANCED FUNCTION)

L 1 NOTE ¢ ]

- Knowledge of Windows application development techniques are
necessary in using this function. The sample program introduced
here is written in Visual Basic, and utilizes Windows API functions.
Therefore, knowledge of Visual Basic (particularly DDE
conversation) and knowledge of API functions described in the
Windows SDK are required. Also, be absolutely sure to use
DDEML.DLL (the DDE management library) when creating a DDE
client application using C++ or another language.

+ Note that this advanced function cannot operate with Visual Basic
verd.0 (32bit issue).

The Test Executive program monitors each executing channel at a constant interval.
If there is a change in status (such as a change from full charge status to full charge
rest status), BP checker can, if required, retrieve graph data from PFX units.
However, this type of status monitoring can all only be performed within the Test
Executive program.

But what should you do if you want to trigger some action depending on the
execution status of a channel? For example, this may occur when you want to control
an thermostatic chamber in response to changes in the testing process or display
voltage or temperature transitions on an external terminal device or printer. These
functions are not included in the BP checker programs, much less something that can
be done by the user through improvements to these programs.

But is there no way for application programs to find out status changes in tests under
execution? Actually, there is a way. You just need to use the DDE (Dynamic Data
Exchange) functions built into Windows. DDE is a standard method for
implementing communications between Windows applications. DDE server
functions (a function to supply data) are built into Test Executive. This function can
be implemented if you build a DDE client application (to accept the supplied data).

Obtained information

The DDE functions supported by Test Executive can be grouped into the following
two broad categories.
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m Notification of changes in status
m Notification of status monitor value

"Notification of changes in status" means that it is possible to notify an external
application of status changes which occur during testing. For example, a typical
status change would be a transition from full charge to full charge rest. This function
can be used to notify the current cycle number and status after the change.

"Notification of status monitor value' means that an external application can be
notified of various monitored values as set intervals regardless of changes in status.
Rather than just notifying the current cycle number and status, this function can be
used to also notify data items such as current, voltage and temperature. The set
interval used is that set for the timer under Test Executive.

Once a conversation has been established, these notification functions can be used to
spontaneously send data from Test Executive to an external application.
Accordingly, the external application program does not need to actively retrieve data.
Services using DDE allow realtime data notification by using automatic links (also
called hot links).

Service name, topic name, item name

Now let's look at what's necessary in creating an actual DDE client application.

A DDE server application identifies data or service requested by a DDE client by
service name, topic name and item name. All of these are represented by a character
string. Although Test Executive has only one service name, it has two types of topic
names depending on the function classification previously described.

B Notification of changes in status
The following names can be used with this function.

Service name BPCRUN
Topic name  STATUS
Item name UxCx

Pay particular attention to the item name, UxCx, given here. In actual practice, the x
parts of the item name are the associated unit number and channel number,
respectively. For example, the item name for unit number 1 (the first PFX unit) and
channel number 4 would actually be U1C4. Also, there is no upper/lower case
distinction in these names.

B Notification of status monitor value
The following names are used with this function.

Service name BPCRUN
Topic name MONITOR
Item name UxCx
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Sample 1

For this function, the topic name changes to MONITOR. Everything else is the same
as for notification of changes in status. The next section will finally give an example

of an actual DDE conversation using Visual Basic. Please use Visual Basic version 2
or higher. All samples in this manual are written in Visual Basic 3.0.

Finding changes in status
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To notify changes in status, use the STATUS topic described above. First, run Test
Executive. It doesn't matter if there are no channel windows open, you can just
iconize Test Executive. Iconization is recommended so that the Test Executive
window doesn't interfere with Visual Basic windows. Now start Visual Basic.

Under the Visual Basic development environment, first place a label control and a
text box control on the main form as shown in the figure below.

0T exﬂ N ®

Figure A3-1 Placing Controls on the Main Form

Now, change the Caption property of the label control (Labell) to "Status."

Status Textd = |-

Figure A3-2 Changing the Label Control Caption

Finally, change the link-related properties of the text box control (Textl) as shown
below. Be sure to set the LinkMode property last. (Operations are guaranteed to fail
if you set LinkMode before properly setting LinkTopic and LinkItem.)

LinkTopic BPCRUNISTATUS
LinkItem UIC1
LinkMode 1 - Automatic



Properties

| Text1 TextBox

HideSelection
Index

Left

Linkltem
LinkMode
Link Timeout

Link.T opic

MaxLength
MousePointer
MultiLine
Name
PasswordChar
ScrolBars
Tablndex
TabStop

Tag

Text

Top

PARAEPCRLUNISTATLS

True

1320

uict

1 - Automatic

50
BFCRLMISTATUS
0

0 - Default

False

Textl

0-None
1
True

STATUSC; 0
120

Figure A3-3 Setting Text Box Properties

Once these properties are set, the text box control display (actually the Text property)
will change to "STATUS 0; 0" as sent from Test Executive. The first O represents the
status, while the second 0, represent the current cycle number. Since no testing is

being conducted on Channel 1 of Unit 1, both read 0.

Status

STATUS 0: 0

Figure A3-4 Data Sent from Text Executive

Now, call up the previously iconized Test Executive, and try running Channel 1 of
Unit 1. After the first status is monitored, the display in the text box control will
change again. This display is not updated every timer tick of Test Executive, but
rather updated only when the status actually changes. In the example below, a
notification is made because a channel which was in IDLE status changes to "Full

Charge'.
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— Form1 I_I_

Status Esmrus 7:1 Ei R

Figure A3-5 Data Sent from Test Executive (During Test Execution)

All notifications from Test Executive are in text format. Multiple data are notified in
a formatted style. The meaning of this notification text string will be explained later.

Sample 2 Obtaining status monitor values

To notify each status value which is monitored, use the MONITOR topic described
previously. Change the Caption property of the label control created in the previous
example to '"Monitor"".

Figure A3-6 Changing the Label Control Caption

Finally, change the link-related properties of the text box control (Textl) as shown

below.
LinkTopic BPCRUNIMONITOR
LinklItem UICI
LinkMode 1 - Automatic
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Properties

I Textl TextBox ng
P EFCR LUNIMONITOR, B

Height 375
HelpContextiD 0
HideSelection True

Index

Left 1320
Linkltem uict
LinkMode 1 - Automatic

Link Timeout 50
Link T opic BFCRUMMONITOR

MaxLength 0
MousePointer 0 - Default
MultiLine False
Name Textl
PasswordChar

ScrolBars 0-None
Tablndex 1

TabStop True

Tag

Figure A3-7 Setting Text Box Properties

Once these properties are set, the text box control display (actually the Text property)
will change to the contents of the monitor. The first number represents the status,
while the second number represents the current cycle number. The remaining values
represent current, voltage and temperature, respectively.

- Form1 [_[_

Monitor IMONITOR 7. 1; 3.000; 1.002; 0.00 { - -

Figure A3-8 Data Sent from Text Executive

Unlike notification of change in status, this display is actually updated every timer
tick of Test Executive. If the timer is set for 10 second intervals, this display will be
updated every 10 seconds.

All notifications from Test Executive are in text format. Multiple data are notified in
a formatted style. The meaning of this notification text string will be explained in the
next section.
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Format of notification data

Notification messages are sent as text strings whether you use notification of changes
in status or notification of status monitor value. The format for each type of
notification is explained here.

MString used for notification of changes in status
STATUS status; _cycle
| L Cycle No.
Status
The cycle number returns O when IDLE and a value of 1 or greater while executing.

Status is represented by a numeric value shown in the table below. Each numeric
value is delimited by a semicolon.

Note that no value is defined for HOLD status. Test Executive does not recognize
that status has changed when a transition from one status to HOLD occurs or when
HOLD status is released. DDE conversation using the STATUS topic therefore
cannot be used to detect HOLD status. If you need to make notifications of HOLD
status you need to set up communications using the MONITOR topic.

Meaning Value
Idle 0
Initial charge 1
Cycle charge 2
Cycle charge rest 3
Cycle discharge 4
Cycle discharge rest 5
Pre-discharge 6
Full charge 7
Full charge rest 8
Full discharge 9
Full discharge rest 10
Post-charge 11
End 13
Recharge 14
Alarm 20

B String used for notification of status monitor value

MONITOR status; cycle; curr, volf. temp; time
I Elapsed time [hh:mm:ss]

Temperature [TC]
Voltage [V]
Current [A]
Cycle No.
Status
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The cycle number returns O when IDLE and a value of 1 or greater while executing.
Status is represented by a numeric value shown in the table below. The remaining
values represent current, voltage and temperature, respectively. Each numeric value
is delimited by a semicolon.

Note that the value associated with HOLD status is the value of the last status plus
256. For example, the status identification number of full charge is 7. If HOLD status
occurs during full charge status the result is 263. Naturally, HOLD status does not
occur during IDLE or END status.

Meaning Value

Idle

Initial charge

Cycle charge

Cycle charge rest
Cycle discharge
Cycle discharge rest
Pre-discharge

Full charge

Full charge rest
Full discharge

O 00 N N W — O

Full discharge rest 10
Post-charge 11
End 13
Recharge 14
Alarm 20
Meaning Value
Hold 256

A status value of 0 (IDLE) is notified when a test is RUN or QUIT.

Other communications functions

The Test Executive program includes several other data retrieval functions in
addition to the various services using DDE functions. DDE-based services are used
for realtime data notification using dynamic links. However, it is possible to retrieve
data using simpler communication methods when that data does not change during
test execution.

Test Executive can respond to external window messages. If you send the
appropriate window message from Visual Basic, a simple kind of communication
can be established. However, Windows API must be used in order to send a window
message. Fortunately, Visual Basic is equipped with functions for accessing
Windows APIs. Here, we will describe how to retrieve data using two API functions:
SendMessage() and FindWindow(). Use the Declare statement of Visual Basic to call
Windows API.

For details on these API functions, please refer to the Windows SDK and Visual
Basic Professional Edition manual.
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This simple communications method can be used to retrieve data such as that listed
below.

®m  Retrieving the operation mode

m  Retrieving the folder file name

m  Retrieving the active worksheet number

® Retrieving the data directory name

"Retrieving the operation mode' means to find out whether the BP checker system is
operating in life cycle mode or sequence mode. "Retrieving the folder file name"
returns the file name (full path name) of the folder assigned to the specified channel.
"Retrieving the active worksheet number" returns the number of the worksheet
currently active. '"Retrieving the data directory name" returns the name of the data
directory for the specified channel.

B Retrieving a window handle

Before sending a window message to the Test Executive program, you must first find
out Test Executive's window handle. This is because the first parameter of the
SendMessage() function is the window handle of the recipient window. So how do
you find out the window handle? The answer is use the FindWindow() function. The
FindWindow() function uses the window class name or caption character string (the
character string appearing on the title bar) of a window and searches all windows in
the Windows system (excluding MDI child windows) until it finds one that matches
the given condition. To find the window handle of Test Executive use the window
class name "BpcRunFrame".

B Sending messages

Once you have determined the window handle of the recipient window, all you have
to do is send a message using the SendMessage() function. Message parameters
WParam and LParam are especially important.

You must specify a combination value of desired unit number and channel number
on the WParam. Specify the unit number in the lower byte of WParam, and the
channel number in the upper byte. Note that these numbers are counted from 0. For
example, if specifying channel 1 of the first unit, both the unit number and channel
number should be specified as 0.

The meaning of LParam differs depending on the message. The meaning of the
return value of SendMessage() also depends on the message.



The following listing is part of a program used to retrieve the data described so far.

This data is retrieved using the SendMessage() function.

' Message constant definitions

Const WM_USER = &H400

Const FW_CHECKSEQMODE = WM_USER + 500
Const FW_GETFOLDERNAME = WM_USER + 501
Const FW_GETACTIVEWKS = WM_USER + 502
Const FW_GETDATADIR = WM_USER + 503
Const FW_GETTICKRATE = WM_USER + 504

' Declaration for calling Windows APls

Declare Function SendMessage% Lib "user" (ByVal hWnd%, ByVal Msg$,
ByVal WParam$%, ByVal LParam As Any)

Declare Function FindWindow% Lib "user" (ByVal lpszClassName As
Any,ByvVal lpszCaption As Any)

' Retrieve BPG/RUN window handle
hwWwndBpc% = FindWindow("BpcRunFrame", 0&)
If hWndBpc% <> 0 Then 'If handle is obtained (if other than 0)...
' Form unit number and channel number
WParam% = (nUnitNo% - 1) + ((nChanNo% - 1) * 256)
' Check operation mode
bSeq% = SendMessage(hWndBpc%, FW_CHECKSEQMODE, 0, 0&)
' Retrieve folder name
sFolder$ = Space$(128)
r& = SendMessage(hWndBpc%, FW_GETFOLDERNAME, WParam%, sFolder$)
' Retrieve active worksheet number
nActiveWks® = SendMessage(hWndBpc%, FW_GETACTIVEWKS, WParam$,
0&)
' Retrieve data directory
sDataDir$ = Space$(128)
r& = SendMessage (hWndBpc%, FW_GETDATADIR, WParam%, sDataDir$)
' Retrieve timer tick speed
Tick& = SendMessage (hWndBpc%, FW_GETTICKRATE, 0, 0&)

End If

M Retrieving the operation mode

This message finds out whether the BP checker system is operating in life cycle

mode or sequence mode.

Message Name FW_CHECKSEQMODE (&H400 + 500)
WParam None (always 0)

LParam None (always 0)

Return value 1 = sequence mode; 0 = life cycle mode
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M Retrieving the folder file name

This message returns the file name (full path name) of the folder assigned to the
specified channel.

Message Name FW_GETFOLDERNAME (&H400 + 501)

WParam Lower byte = unit number-1
Upper byte = channel number-1
LParam Pointer to string buffer

Return value None

B Retrieving the active worksheet number

This message returns the number of the active worksheet in the folder assigned to the
specified channel.

Message Name

FW_GETACTIVEWKS (&H400 + 502)

WParam

LParam
Return value

Lower byte = unit number-1

Upper byte = channel number-1

None (always 0)

Represents worksheet number if 1 or greater
No worksheet found if 0

M Retrieving the data directory name

This message returns the name of the data directory for the specified channel.

Message Name

FW_GETDATADIR (&H400 + 503)

WParam

LParam

Return value

Lower byte = unit number-1
Upper byte = channel number-1
Pointer to string buffer

None

B Retrieving the timer tick speed

This message returns the timer tick speed set within Test Executive.

Message Name

FW_GETTICKRATE (&H400 + 504)

WParam
LParam

Return value

None (always 0)
None (always 0)
Timer tick speed (unit: milliseconds)




APPENDIX 4 APPLICATION SPECIFICATIONS

Hardware Requirements (Minimum Requirements)

Computer

IBM-PC/AT compatible

80386 CPU or better

4MB RAM or better

VGA or better display adaptor and color monitor
3.5-inch diskette drive (1.44MB)

Hard disk

Microsoft mouse or compatible pointing device

Operating system

Microsoft Windows 3.1/3.11, Windows for
Workgroups 3.11 or Windows 95

Printer

Printer supported by Microsoft Windows

GPIB board

National Instruments NI-488.2-compatible GPIB

PEX Config

Setup functions

System configuration
Specifies number of PFX40W-08 units (up to 6)
Switches operation mode (sequence/life cycle)
Unit configuration
Sets testing environment
Sets cycle format
Sets synchronous testing

GPIB communications functions

Sends the above setup data

Folder Editor

Setup functions

Edits battery information and worksheets

Specifiable testing modes

Cycle charge (shallow charge)
CC/CCCV/CC-Pattern/CCCV-Pattern
Cycle discharge (shallow discharge)
CC/CP/CC-Pattern/CP-Pattern
Full charge (deep charge)
cc/ccev
Full discharge (deep discharge)
CC/CP
Initial charge
CC

Maximum number of worksheets

99

GPIB communications functions

None
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Test Executive

BPC Graph

BPC Spy
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Testing functions

Retrieves characteristics data (voltage, current, temperature,
life characteristics. However, only for full charge, full

Maximum number of channels

48 (8 channels x 6 units)

GPIB communications functions

Transfers worksheets
Monitors test progress status
Retrieves graph data

Display functions

Table format display of characteristics data
Graph display of characteristics data
Graph overlay (up to three layers)

Test reports (text format)

Test conditions (text format)

Printing functions

Graphs and overlay graphs (color-compatible)
Test reports (text format)
Test conditions (text format)

Data pasting functions

Pasting of table format contents to spreadsheet software via
the clipboard
Pasting of text format data to word processing software via
the clipboard

GPIB communications functions

None

Monitoring functions

Test progress status and monitor values

Monitoring conditions

Synchronized with Test Executive
Any one of:

By amount of change in monitor value
By percent of change in monitor value

Display functions

Displays monitor data in table format

Data pasting functions

Pasting of data to spreadsheet software via the clipboard

GPIB communications functions

None
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